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D A F T A R   I S T I L A H 

.SHP : Ekstensi dari file berformat Shapefile, yaitu file peta dari Environmental Systems Research 

Institute (ESRI). Peta dalam format ini sudah dikenal luas, sehingga hampir menjadi 

standar untuk pemetaan. 

Adobe Flash 

Player 

: Perangkat lunak untuk menjalankan file animasi berformat Flash atau berekstensi .SWF. 

Animasi : Gambar bergerak, yaitu rangkaian gambar yang ditampilkan berurutan sesuai dengan 

berubahnya waktu (hal. 8). 

Antarmuka : Bagian dari program aplikasi komputer yang menjadi sarana untuk pengiriman perintah 

kepada program atau juga disebut sebagi media bagi pengguna untuk berkomunikasi 

dengan program komputer. 

Bar Indikator : Diagram batang yang menggambarkan tinggi rendahnya nilai Indikator. 

BMP : Salah satu jenis format file untuk gambar, juga disebut Bitmap. 

Bookmark : Penanda indikator penting agar dapat cepat dipanggil jika dibutuhkan (hal. 3). 

Copy : Merekam sesuatu yang sedang ditandai, lalu menyimpan dalam penyimpanan sementara 

(clipboard). 

Crash : Komputer dalam keadaan Crash, terjadi jika tiba-tiba komputer berhenti berproses, tidak 

dapat menerima perintah dari manapun. Penyebabnya sangat beragam, yang umum 

adalah karena perangkat keras komputer tidak mampu melaksanakan yang diperintahkan 

oleh sistem operasi. 

CSV : Comma-Separated Value, yaitu file berformat text untuk menyimpan data tabuler. Tiap 

kolom dipisahkan oleh tanda koma 

Default : Nilai standar suatu parameter tertentu (hal. 24). 

Diagram Batang  : Bar Chart – salah catu cara menggambarkan nilai kuantitif dalam bentuk gambar batang 

yang ukurannya bergantung pada nilai yang dikandungnya (hal. 5). 

Drag : Perintah melalui mouse, yaitu klik kanan, lalu geser kursor tanpa melepas tombol mouse. 

Tombol mouse dilepas setelah kursor berada dilokasi yang diinginkan 

Drop-down : Salah satu bentuk Menu pada progam komputer, dimana daftar plihan perintahnya akan 

muncul saat melakukan klik pertama pada area tersebut. Klik berikutnya adalah 

pengiriman perintah atau pilihan. 

ESRI : Environmental Systems Research Institute - Perusahaan pembuat perangkat lunak 

dibidang informasi kebumian, yang berpusat di Redlands, Califorinia, Amerika Serikat. 

Flash, Adobe 

Flash 

: Jenis format yang yang digunakan untuk menyimpan file animasi. Flash dibuat oleh Adobe 

dan berekstensi SWF. 

GIF : Graphics Interchange Format – salah satu jenis format file untuk menyimpan data gambar 

bitmap. 

IIEP : International Institute for Educational Planning – Lembaga Pendidikan yang dikelola oleh 

Unesco. 

Indikator : Variabel yang datanya ditampilkan dalam peta pada aplikasi StatPlanet. 

ISO3 : Kode standar singkatan nama-nama negara di dunia. 

JPEG/JPG : Joint Photographic Experts Group – salah satu jenis format file untuk menyimpan data 

gambar bitmap. 
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Kategori : Kelompok-kelompok variabel yang memiliki tema data yang sama pada aplikasi StatPlanet. 

Macro : Kode pemrograman yang dijalankan pada aplikasi MMS Office, yang digunakan untuk 

membuat perintah-perintah khusus. Tujuan pembuatan Macro terutama untuk 

otomatisasi proses (hal 16).  

Mouse Over : Keadaan saat kursor bergerak melintasi obyek gambar tertentu. 

Panel : Komponen-komponen antarmuka StatPlanet, untuk menyajikan satu bagian tertentu. 

Misalnya Panel Data Tabel adalah antarmuka untuk menyajikan tabel data. 

Paste : Proses memunculkan kembali data yang disimpan dalam clipboard atau dari proses Copy. 

Peta Choropleth : Peta tematik dimana obyek peta berupa poligon-poligon yang menggambarkan wilayah, 

dan dengan warna-warna atau arsiran yang melambangkan nilai data. 

Piksel : Satuan area terkecil untuk file gambar berformat bitmap. 

PNG : Portable Network Graphics – salah satu jenis format file untuk menyimpan data gambar 

bitmap. 

Popup : Kotak dialog baru dalam program berbasis Window, yang muncul sebagai akibat dari 

pengiriman perintah tertentu kepada program, misalnya perintah klik kanan pada mouse. 

SACMEQ : Southern and Eastern Africa Consortium for Monitoring Educational Quality – organisasi 

pengembangan non profit yang beranggotakan 15 kementrian pendidikan di negara-

negara Afrika bagian selatan dan timur. 

Scatter Plot : Diagram statistik yang menggunakan koordinat kartesius, dan sumbu X dan Y sebagai 

variabelnya. 

Shapefile : lihat .SHP 

Sheet : Pada aplikasi MS Excel, merupakan halaman-halaman dari lembar kerja. Halaman-halaman 

ini dapat diberi nama sesuai kebutuhan. 

Speadsheet : Salah satu jenis perangkat lunak untuk perkantoran yang utamanya digunakan untuk 

pembuatan tabel-tabel yang kompleks. Contohnya adalah MS Excel.  

Stand-Alone : Aplikasi komputer yang dapat dijalankan dalam satu komputer saja, tanpa perlu koneksi 

dengan internet (hal. 1). 

SVG : Scalable Vector Graphics – salah satu jenis format file untuk menyimpan data gambar 

bertipe vektor (hal. 33). 

SWF : Shockwave Flash – salah satu jenis format file untuk menyimpan file animasi (hal 33). 

Template : Contoh desain yang dapat diubah dan dikembangkan lebih lanjut oleh pengguna. Biasanya 

digunakan untuk mempermudah pengguna dalam menyusun hasil akhir yang diinginkan. 

Time Series : Sekelompok data pada tema yang sama, tetapi memiliki variabel waktu yang berbeda dan 

tetapi masih berurutan. 

Troubleshooting : Kumpulan cara-cara untuk memperbaiki kekeliruan. 

Zoomslider : Pengontrol tampilan layar yang penggunaannya dengan cara klik lalu geser ke kiri-kanan 

atau atas-bawah untuk memperbesar atau memperkecil tampilan pada layar monitor. 
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1. TENTANG 

StatPlanet dan StatTrends adalah alat untuk memvisualisasi data secara interaktif dan juga 

sebagai alat untuk pemetaan. StatPlanet sudah digunakan oleh berbagai organisasi, termasuk 

agensi-agensi PBB, Perusahaan-perusahaan, Instansi pemerintah, LSM, sekolah-sekolah dan 

Universitas, untuk menginformasikan, menyebarkan dan mengekplorasi data. StatPlanet tidak 

hanya untuk orang dewasa, tetapi dapat juga digunakan oleh anak-anak (usia 9 tahun keatas) 

untuk belajar mengenai dunia melalui peta interaktif. 

StatPlanet dan StatTrends dapat digunakan oleh pengguna yang awam akan hal teknis dalam 

mengeksplorasi data statistik melalui antarmuka yang mudah digunakan. Selain itu, perangkat 

lunak ini mengotomatisasi proses yang biasanya kompleks, yaitu mengubah data menjadi peta 

interaktif dan visual. Hal ini bahkan bagi pengguna yang tidak memahami teknis pun dapat 

membuat peta interaktif relatif secara lebih mudah. Anda dapat mengimpor data Anda sendiri 

ke dalam StatPlanet, begitu juga dengan peta-petanya (baik itu Flash map ataupun peta ESRI 

shapefile) – atau menggunakan peta dunia atau peta Amerika yang disertakan dalam paket 

StatPlanet. 

StatPlanet dibuat dalam beberapa versi untuk memenuhi berbagai kebutuhan. Semua versi 

StatPlanet adalah gratis, kecuali StatPlanet Plus, yang memiliki fitur untuk penggunaan tingkat 

lanjut, seperti dukungan terhadap database yang besar. Semua versi StatPlanet dapat 

digunakan sebagai aplikasi Stand-Alone untuk yang tidak terhubung ke internet atau sebagai 

aplikasi web yang dipublikasikan secara online. StatPlanet Plus versi offline adalah gratis untuk 

penggunaan non komersial. 

Tujuan StatPlanet adalah untuk mendorong pengambilan keputusan berbasis pada fakta 

melalui penyediaan dan peningkatan kualitas komunikasi dan peningkatan interpretasi 

informasi. StatPlanet melakukan semua ini dengan menyediakan (i) visualisasi interaktif yang 

atraktif yang menyediakan interpretasi informasi, (ii) tampilan antar muka yang mudah yang 

dapat digunakan juga oleh pengguna biasa, (iii) tampilan data yang otomatis (termasuk proses 

penggabungan dan sinkronisasi data dari sumber-sumber yang berbeda), (iv) perangkat lunak 

yang mudah didistribusikan yang memudahkan orang untuk mengeksplor dan membuat 

visualisasi data, meski tanpa memiliki kemampuan teknis, ketersediaan koneksi internet dan 

perangkat keras dan perangkat lunak komputer. 

StatPlanet dan StatTrends dibuat oleh StatSilk, sebuah perusahaan Autralia yang didirikan oleh 

Frank van Cappelle. Dari tahun 2008 sampai 2010 pengembangan versi buatan sendiri diambil 
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alih menjadi bagian dari Program Penelitian SACMEQ pada Institut International Perencanaan 

Pendidikan (IIEP), UNESCO, Paris, Perancis. 

Informasi lebih jauh, kunjungi www.statsilk.com 

  

http://www.statsilk.com/
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2. KEBUTUHAN SISTEM 

StatPlanet dan StatTrends dirancang agar dapat digunakan dimanapun, tanpa memandang 

ketersediaan komputer dan infrastrukturnya. Baik itu online, melalui intranet ataupun offline – 

yang artinya tetap dapat digunakan meskipun tanpa koneksi internet. StatPlanet mudah 

didistribusikan karena ukurannya yang sangat kecil, cukup kecil hingga dapat disimpan dalam 

USB flashdisk atau disertakan dalam email. Aplikasinya tidak memerlukan proses instalasi, 

sehinga meski tanpa status sebagai administrator komputer pun, tetap dapat menjalankan 

program ini baik online maupun offline. 

Perangkat lunak ini dijalankan melalui Adobe Flash Player, yang hanya memerlukan standar 

spesifikasi komputer yang minimum1. Seperti yang dapat dilihat pada tabel, spesifikasi yang 

dibutuhkan cukup rendah, bahkan komputer yang dibeli 8 tahun yang lalu pun seharusnya 

dapat menjalankan StatPlanet. 

Windows® Macintosh Linux® 

Intel® Pentium® II 450MHz, AMD 
Athlon™ 600MHz atau yang lebih cepat 
(yang sebanding) 

PowerPC® G3 500MHz 
atau yang lebih cepat 
 
Intel Core™ Duo 
1.33GHz atau yang 
lebih cepat 

Modern processor 
(800MHz atau yang lebih 
cepat) 

RAM 128MB RAM 128MB RAM 512MB, memory 
grafis 128MB 

VRAM 128MB* 

*Direkomendasikan untuk fitur acceleration-dependent pada perangkat keras GPU. Flash Player 

akan menggunakan mode pada perangkat lunak yang tidak cocok dengan kebutuhan sistem. 

                                                      
1
 http://www.adobe.com/products/flashplayer/systemreqs/ 

http://www.adobe.com/products/flashplayer/systemreqs/
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3. FITUR DAN PENGATURAN 

 

3.1. Peta Tematik 

 

 

Peta Choropleth 

Ini adalah jenis peta tematik utama pada StatPlanet. Legenda peta menyajikan warna-warna 

peta yang berkaitan dengan tiap kelas data, misalnya nilai yang lebih tinggi akan diberi warna 

yang lebih gelap. Baik warna peta maupun warna pada kelas data dapat diatur sendiri (dapat 

dilihat pada bagian Legenda Peta). Pada versi 2.1 sebelumnya, baru diperkenalkan 

kemungkinan untuk membuat peta kualitatif atau deskriptif. Peta-peta seperti ini dapat 

menggambarkan informasi yang bukan numerik, dimana kata-kata dapat menjelaskan 

perbedaan wilayah.  

 

 

Peta Simbol Proporsional 

Peta Simbol Proporsional menggambarkan ukuran simbol (biasanya berupa lingkaran) sesuai 

dengan indikator yang dipetakan. Setiap simbol mewakili sebuah negara atau wilayah 

tertentu. Pada StatPlanet, simbol ditumpangkan diatas peta choropleth (lihat dibagian atas). 

Ini berarti dua buah dataset dapat ditampilkan bersamaan, yang satu sebagai peta choropleth 

dan yang satu lagi sebagai peta simbol. 
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Untuk menampilkan peta simbol, klik pada icon simbol (pada bagian kiri) di sudut kiri-bawah  

layar. Bila sebelumnya sudah menandai (bookmark) suatu indikator, peta simbol akan 

menampilkan data dari indikator yang sudah ditandai tadi, dimana peta choropleth 

menampilkan data dari indikator yang dipilih. (Bila indikator yang sedang ditandai, juga sedang 

dipilih, peta simbol dan choropleth akan menampilkan indikator yang ditandai). 

  Memilih wilayah negara pada peta dunia 

 Mouse over suatu wilayah negara: Melewatkan kursor diatas suatu wilayah negara 

akan menampilkan sebuah window popup yang berisi informasi mengenai negara 

tersebut sesuai dengan indikator yang dipilih (atau juga indikator pada bookmark, jika 

ini yang dipilih). Sebagai tambahan, data negara untuk semua indikator pada kategori 

yang sedang dipilih, ditunjukan pada panel indikator. 

 Klik pada wilayah negara: Wilayah negara tertentu dapat dipilih dengan di-klik pada 

peta. Cara ini membuat negara tersebut dibagian grafik, akan ditandai, dan juga ini 

dapat digunakan untuk menyusun kelompok regional tertentu. Lihat dibagian panel 

pemilihan negara. 

  Legenda Peta 

Pewarnaan Peta: Klik pada tempat berwarna di legenda, akan memunculkan panel pilihan 

warna. Melalui panel ini, skema pewarnaan dapat diubah (baik itu Sequential, Diverging atau 

Color Picker), dan juga untuk mengubah jumlah kelas warna (antara 3 sampai 9). Skema 

pewarnaan ini diambil dari website Color Brewer (http://colorbrewer2.org),  yang merupakan 

sumber terpercaya untuk informasi mengenai pemilihan warna peta. 

Jangkauan Data: Untuk mengatur jangkauan data pada legenda peta, klik pada nilai teratas 

atau paling bawah. Gunakanlah popup yang muncul untuk menaikan atau menurunkan 

nilainya, atau masukan nilai yang sama sekali baru. Nilai-nilai antara akan ditentukan secara 

otomatis. 

Peta Buatan Sendiri (nasional/provinsi/kabupaten, dll) 

StatPlanet juga dapat digunakan untuk memasukan peta buatan sendiri, yaitu dengan 

menggunakan template peta (map.fla). Untuk keperluan ini, membutuhkan perangkat lunak 

Adobe Flash (lihat bagian 4. Mengimpor atau Membuat Peta). 

 

 

Menyimpan/Mengekspor (Hanya untuk StatPlanet Plus/StatTrends Plus) 

Untuk menyimpan atau mengekspor peta dapat melalui tombol ‘Save/Export’ pada sudut kiri-

bawah dari layar monitor. Tombol ini juga dapat digunakan untuk menyimpan peta yang 

http://colorbrewer2.org/
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sedang tampil ataupun grafik menjadi sebuah file gambar, juga untuk mengunduh datanya 

menjadi file CSV. 

Untuk mengubah tipe file gambar, ukuran atau kualitas, gunakan panel Options. Fitur ini hanya 

tersedia pada versi online di website StatPlanet. Bagaimanapun, menyimpan peta  dari data 

yang kita susun menjadi sebuah gambar, dapat dilakukan dengan mengunduh StatPlanet Map 

Maker. Jalankan StatPlanet pada folder Offline, klik pada icon yang muncul pada bagian kiri, 

lalu gunakan ‘Print Screen’ (tombol Prt Scr pada keyboard). Cara ini akan menyimpan tampilan 

layar, sehingga dapat dicopy-kan ke editor gambar atau dokumen.  

Disarankan untuk mencantumkan StatPlanet sebagai referensi jika akan mempublikasikan 

gambar tersebut. 

 

 

Kontrol Navigasi Peta 

Kontrol untuk memperbesar/memperkecil peta, normalnya tidak tampak di layar. Jalankan 

kursor mouse ke arah kanan-bawah layar, maka kontrol navigasi ini akan muncul: 

 Zoom: Untuk memperbesar atau memperkecil peta, menggunakan tombol ‘zoom in’ 

dan ‘zoom out’ atau dengan klik sambil digeser tanpa mengangkat tombol mouse ke 

atas atau ke bawah pada zoom slider. 

 Menggeser peta: Klik peta lalu geser tanpa mengangkat mouse, dan melepaskan 

tombol kanan mouse setelah peta mencapai lokasi baru. 

 Mengembalikan tampilan peta ke posisi awal: Tombol yang ditampikan diatas adalah 

tombol untuk mengembalikan posisi peta seperti pada awalnya .  

3.2. Panel Indikator 

 

 

Memilih Kategori 

Gunakanlah menu drop-down pada bagian atas panel indikator untuk memilih kategori baru 

(hanya untuk yang versi online) 

 

 

Memilih Wilayah Regional 

Gunakanlah menu drop-down pada bagian atas panel indikator untuk memilih dan 

memfokuskan ke wilayah regional yang lain, misalnya ke afrika atau eropa. Bisa juga 

dilakukan memilih wilayah-wilayah pada peta yang akan dimasukan dalam wilayah regional 

tersendiri (Lihat dibagian Panel Seleksi Wilayah/Lokasi). 
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Bar Indikator 

Ukuran Bar Indikator secara proporsional akan menyesuaikan terhadap berapa nilai 

maksimum pada wilayah-wilayah yang terpilih. Sebagai contoh, negara X nilainya 20 dan 

nilai maksimum dari semua negara yang dipilih adalah 100, jadi ukuran bar untuk negara X 

menjadi 20%.  

 

 

Menandai Indikator 

Klik tanda bintang pada panel indikator untuk menandai indikator tertentu. Indikator yang 

ditandai akan tetap muncul meskipun kita sudah pindah ke kategori yang lain. Jadi dapat 

digunakan untuk (i) membuat grafik scatter plot, (ii) membandingkan indikator yang sudah 

ditandai dengan indikator dari kategori yang lain, dan (iii) membandingkan dua indikator 

yaitu peta choropleth (menyajikan indikator yang dipilih) dengan peta simbol proporsional 

(menyajikan indikator yang ditandai). 

  Definisi Indikator 

Jika ada definisi untuk sebuah indikator, definisi ini akan muncul sebagai popup saat 

menggerakan mouse melalui indikator tersebut. Definisi ini hanya muncul pada indikator 

yang dipilih atau ditandai. 

3.3. Panel Grafik 

 

 

Diagram Batang 

Klik tombol ‘graph’ pada bagian kiri-bawah layar untuk membuka atau menutup panel grafik. 

Tombol ini juga terdapat pada panel grafik dan juga digunakan untuk mengatur tampilan 

diagram batang menjadi horizonal ataupun vertikal. 

Gunakanlah tombol ‘sort’ untuk mengurutkan grafik dengan pilihan nilai terkecil ke terbesar, 

terbesar ke terkecil, terbesar ke terkecil yang dimulai dari tengah dan alfabetis. 

 

 

Time Series 

Pada bagian kiri-atas dari panel grafik, (perhatikan ‘Diagram Batang’ diatas), ada tombol Time 

Series. Jika tombol itu di-klik, grafik akan meminta untuk memasukan nama wilayah atau 

negara. Klik pada daftar nama negara/wilayah untuk menambahkan dan klik sekali lagi untuk 

menghapusnya. (Lihat di bagian Seleksi Wilayah/Lokasi dibawah ini) 

Klik tambol ‘Sort’ untuk mengurutkan label time series. 
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Scatter Plot 

Dibagian kiri-atas panel grafik ini (lihat ‘Diagram Batang’ diatas) juga terdapat tombol Scatter 

Plot yang jika di-klik, secara otomatis indikator yang terpilih akan menjadi variabel sumbu-X. 

Lalu perlu dipilih indikator lain yang akan dijadikan sebagai variabel sumbu-Y. 

Variabel sumbu-X dan Y dapat ditentukan melalui panel grafik (lihat dibawah) atau pada panel 

indikator (lihat bagian ‘menandai indikator’ diatas). 

Tekan tombol ‘play’ untuk melihat animasi perubahan sesuai waktu, dimana setiap lingkaran 

(titik) akan bergerak sesuai dengan posisi x dan y (tergantung dari ketersediaan data pada tiap 

interval waktu). Jika tombol ‘Show trails’ tercentang (disebelah tombol ‘play’), tiap titik akan 

meninggalkan jejak untuk menandai posisi sebelumnya sesuai urutan waktu. 

Klik lingkaran pada scatter plot akan menampilkan label dari data yang bersangkutan. Label-

label ini juga dapat digeser dengan cara di-klik lalu geser, yaitu setelah klik kanan dan memilih 

‘Move text labels or map points’. 

Indikator ketiga dapat divisualisasi melalui parameter dari ukuran lingkaran. Indikator ini 

ditentukan dengan menggunakan menu drop-down diatas grafik scatter plot. Ukuran lingkaran 

akan mengikuti formula nilai/nilai maksimum. 

 

 

Memilih indikator sumbu X atau Y 

Klik pada label sumbu-x atau y, lalu pilih indikator melalui menu drop-down. 

Gunakanlah menu drop-down pada bagian atas panel grafik untuk mengatur perubahan 

ukuran lingkaran sesuai dengan indikator yang dipilih. 

 
Gunakanlah icon ‘option’ pada panel grafik untuk menunjukan atau menghilangkan garis 

kecenderungan (trendline). Geser kursor mouse pada garis kecenderungan tersebut untuk 

melihat kemiringan dan persamaan garis. 

 

  

Mengatur ukuran grafik 

Untuk mengubah ukuran grafik, geser kursor mouse ke bagian tepi atau sudut dari panel grafik 

sampai bentuk kursor berubah menjadi garis dengan 2 anak panah. Klik dan tahan tombol kiri 

mouse, lalu geser panel tersebut sampai ukuran yang diinginkan. Lepaskan tombol mouse, jika 

sudah sudah mendapatkan ukuran yang sesuai. 

 Mengatur skala grafik 

Ukuran grafiknya dapat diatur dengan cara klik pada nilai grafik tertinggi atau terendah. Nilai 
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baru dapat dimasukan pada panel popup yang kemudian muncul. 

3.4. Panel Pengaturan 

 

Klik tombol ‘Options & appearance’ pada bagian kiri-bawah layar monitor untuk membuka 

panel pilihan. 

  

Map 

 
 Map colors digunakan untuk mengatur pewarnaan, dengan pilihan bagian yang 

warnanya dapat diatur antara lain: 

Map background – warna dasar peta 

Map borders – warna batas peta 

Map text color – warna teks pada peta 

Map text outline color – warna garis batas pada teks peta 

Dan lain-lain 

 Map font size  untuk menyesuaikan ukuran teks pada peta 

 Map symbol size adalah pengaturan proporsi dari ukuran simbol peta 

 Legend: estimate best value distribtution untuk mengatur nilai agar terdistribusi lebih 

merata untuk tiap kelas warna. Ini biasanya terjadi pada peta yang memiliki distribusi 

warna yang lebih baik. Jika bagian ini tidak dicentang, jangkauan nilai untuk tiap kelas 

warna akan diatur dengan interval yang sama berdasarkan nilai tertinggi dan terendah 

dari jangkauan datanya. 

 Legend: show maximum & minimum untuk menampilkan atau menghilangkan nilai 

maximum dan minimum 

 Map legend colors untuk mengatur warna pada legenda 
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Graph/Chart 

 

 Graph colors digunakan untuk mengatur pewarnaan, dengan pilihan bagian yang 

warnanya dapat diatur adalah Area (bars/point), Background, borders, bubble borders, 

Bullet graph, Grid 

 Graph text size untuk mengatur ukuran teks 

 Transparency  yang digunakan untuk pengaturan tingkat tranparansi 

 Size of bubbles untuk mengatur ukuran dari lingkaran 

 Bullet graph 

General 

 

 Animation duration yaitu pengaturan durasi animasi dalam satuan detik 

 Decimal places untuk mengatur jumlah digit dibelakang koma, pada nilai desimal 

 Adjust map/graph scale: StatPlanet secara otomatis mengatur ukuran peta dan grafik 

agar sesuai dengan data set. Tetapi terkadang pada kasus-kasus tertentu ukuran peta 

dan grafik diharuskan tetap, misalnya jika kita mesti memerlukan beberapa perubahan 

di dalamnya. Ukuran Peta dan grafik dapat diatur agar otomatis berubah (atau tidak 
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berubah) jika terjadi (i) perubahan indikator, (ii) perubahan wilayah, (iii) perubahan 

tahun. Setting standarnya adalah perubahan ukuran jika terjadi perubahan pada 

indikator atau wilayah, tetapi tidak untuk tahun. 

Jika yang dipilih adalah tidak ada perubahan ukuran peta, pada legenda terdapat 

shortcut yang digunakan untuk me-refresh legenda peta kapanpun pada indikator, 

tahun atau wilayah yang sedang dibuka: 

   

Menyimpan/mengekspor peta atau grafik (hanya untuk versi online) 

 Mengatur tipe gambar PNG atau JPEG 

 Mengatur ukuran gambar dalam % dari ukuran aslinya 

 Mengatur kualitas gambar (hanya untuk JPEG) 

3.5. Panel Data Table 

 

Klik pada tombol ‘Table’ dibagian kiri-bawah layar monitor untuk memunculkan tabel data dari 

indikator yang dipilih. Jika suatu indikator sudah ditandai (bookmark), kedua data dari 

indikator yang ditandai dan yang dipilih akan ditampilkan. Tabel tersebut juga menyajikan nilai 

rerata (mean), standar deviasi dan jangkauan (range). 

 

Save/Export Table (Hanya untuk StatPlanet Plus/StatTrends Plus) 

Menyimpan tabel kedalam file CSV, yang juga dapat dibuka oleh umumnya program 

speadsheet (seperti Excel). Tombol untuk ini terdapat di sudut kanan-atas panel tabel. 

 

Copy Table 

Versi offline StatPlanet tidak mengijinkan untuk menyimpan data kedalam sebuah file. Tetapi 

kita tetap dapat meng-copy seluruh data ke dalam file Excel menggunakan tombol ‘Copy’ dan 

memindahkannya ke file Excel. Jika tidak memiliki Excel, dapat juga dilakukan sebagai berikut 

(i) memindahkannya ke program editor seperti Notepad, (ii) menyimpan dokumen ini sebagai 

‘data.html’, (iii) membuka menggunakan Web Browser. 
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3.6. Panel Seleksi Wilayah/Lokasi 

Suatu wilayah (atau pada StatTrends – variabel yang sudah ditentukan) dapat dipilih dengan 

berbagai cara. Cara yang paling mudah adalah dengan mencari dan memilih melalui panel 

‘Select’, seperti yang diuraikan dibawah ini. Tetapi suatu wilayah/negara dapat dipilih juga 

dengan meng-klik wilayah yang bersangkutan pada peta dunia, pada panel tabel atau pada 

grafik batang maupun scatter plot. Nama wilayah yang sedang dipilih akan diberi tanda pada 

semua komponen StatPlanet. 

 

Klik tombol ‘Select’ pada sudut kiri-bawah layar untuk menampilkan daftar nama 

wilayah/negara. Lalu klik lagi untuk memilih negara yang diinginkan agar dimunculkan pada 

panel peta atau grafik. Untuk mempersempit pilihan, pilih dulu regional melalui menu drop-

down pada bagian kanan-atas layar. Mengetikan huruf depan suatu wilayah/negara juga dapat 

mempercepat pencarian nama wilayah/negara dari daftar. 

 

 

Tombol ‘Select’ 

Tekan tombol Select untuk mengkonfirmasi pilihan. Variabel-variabel yang tidak dipilih akan 

dihapus dari tampilan. Catatan: Pada grafik time series, tidak perlu menekan tombol ini karena 

nama wilayah/negara akan segera muncul jika di-klik. 

 

 

Tombol ‘Deselect All’ 

Tekan tombol ‘Deselect All’ untuk menghapus hasil pilihan. 

 

 

Tombol ‘Refresh’ 

Tombol Refresh akan muncul hanya setelah melakukan klik pada tombol ‘Select’. 

 

 

Menghapus hasil pilihan 

Untuk menghapus nama wilayah/negara dari daftar dan juga dari grafik, pilih nama 

wilayah/negara yang akan dihapus lalu klik tombol ini. 

3.7. Time slider 
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Gunakanlah slider atau klik pada anak panah untuk berganti tahun. Klik pada tombol ‘Play’ akan 

menyajikan perubahan waktu dalam bentuk animasi, yang dimulai dari bagian awal. Kecepatan 

animasi diatur pada panel Option. 

3.8. Pengaturan Tampilan 

 

 

Panel Tampilan 

Geser kursor mouse ke tombol ‘View’ pada bagian kiri-bawah layar monitor untuk 

menentukan bagian-bagian peta dan grafik yang perlu ditampilkan atau disembunyikan, 

juga untuk komponen-komponen StatPlanet yang lainnya. 

 Menampilkan atau menyembunyikan nama wilayah/regional pada peta atau grafik 

(nama negara dapat disajikan dalam bentuk nama lengkap atau singkatan atau 

menurut kode ISO3) 

 Menampilkan atau menyembunyikan data statistik pada peta atau grafik (data 

statistik hanya dapat dimunculkan pada diagram bar horizontal) 

 Menampilkan atau menyembunyikan popup peta dan komponen-komponennya, 

diagram batang, indikator dan data statistik 

 Menyajikan dan menyembunyikan berbagai panel. 

  

Mengecilkan/membesarkan Panel 

Gunakanlah tombol seperti gambar disamping untuk memperkecil atau memperbesar 

panel StatPalent. Cara ini bermanfaat untuk pengaturan ruang tampilan ketika 

membuka beberapa panel pada saat yang bersamaan, atau untuk memfokuskan 

tampilan pada area tertentu. 

  

Meminimalkan/memaksimalkan Panel 

Tombol disamping ini untuk meminimalkan atau memaksimalkan tampilan panel. 

Panel indikator memiliki posisi minimal yang khusus dimana indikator-indikatornya 

masih tetap dapat dipilih. 

 

Mengatur ukuran panel grafik 

Klik dan geser (drag and drop) pada bagian batas panel untuk mengatur ukuran panel. 

 

http://en.wikipedia.org/wiki/ISO_3166-1_alpha-3
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Fullscreen 

Klik pada tombol fullscreen pada bagian kiri-bawah layar untuk berpindah ke status 

tampilan layar penuh  atau ke tampilan normal. 

Catatan Tambahan 

 Pada saat berpindah kategori, StatPlanet akan mengingatkan data pada tahun-tahun 

berapa saja yang dipilih dan melakukan mengecekan apakah data tersebut ada untuk 

tahun tersebut pada kategori yang baru dipilih. Jika tidak ada datanya, StatPlanet akan 

memilih tahun yang terdekat dengan tahun yang dipilih sebelumnya yang ada datanya 

untuk kategori yang baru. 

 Pada saat berpindah peta (misalnya peta dunia ke peta negara atau dari peta regional ke 

peta distrik), StatPlanet akan melakukan pengecekan apakah kategori dan indikator yang 

sama ada pada peta yang baru. Jika tidak ditemukan, kategori/indikator pertama pada 

data tersebut yang akan dipilih. 
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4. MENGIMPOR ATAU MEMBUAT PETA 

4.1. Mengimpor peta Shapefile ESRI 

1. Masuk ke folder yang berisi shapefile versi StatPlanet, lalu buka folder ‘map’ 

2. Hapus contoh shapefile yang ada (peta indonesia) dan copy shapefile kita ke dalam 

folder tersebut. Perhatikan bahwa ada dua folder dalam “Shapefile_map_(ESRI)” yang 

diperlukan untuk meng-copy file-file petanya: 

 \map   (untuk versi offline) 

 \web\map   (untuk versi web) 

3. Ubahlah nama file peta (misalnya “mycountry.shp” dan “mycountry.dbf”) menjadi 

“map.shp” dan “map.dbf”. 

4. Bukalah file StatPlanet_data_editor.xlsm. Masuk ke sheet  ‘Import’ dan klik tombol 

‘Setup shapefile’ (pada bagian kiri-atas, macro harus dalam keadaan  aktif/enabled). 

5. Pilihlah ‘map.dbf’ kita pada folder peta, dan ikuti instruksinya. Pastikan bahwa kolom 

‘ID’ berisi data alfabet (a-z) atau alfa-numerik (kombinasi karakter alfabet dan numerik, 

seperti misalnya “disp29”). ID numerik atau karakter khusus seperti ê å & / - dapat 

menyebabkan masalah pada saat program akan menyajikan peta. Jika tidak memiliki 

kolom ID yang sesuai, dapat menggunakan perangkat lunak Open Office Calc untuk 

mengedit file “map.dbf” dan membuat atau mengedit kolom ID. Open Office Calc 

adalah perangkat lunak gratis (http://www.openoffice.org). 

6. Jalankan StatPlanet untuk melihat hasil yang mengikutkan data sampel. 

Proses impor atau memasukan data untuk peta dapat dilakukan, tetapi pertama-tama mungkin 

saja perlu untuk memodifikasi letak peta dan menambahkan label teks. 

Memposisikan Peta: 

Untuk mengubah letak dan ukuran tampilan peta, arahkan kursor mouse ke bagian kanan-

bawah layar untuk menampilkan kontrol tampilan peta: 

 Zoom adalah untuk memperbesar dan memperkecil tampilan dengan 

memanfaatkan tombol ‘zoom in’ dan ‘zoom out’ atau dengan menggeser-geser 

‘zoom slider’ ke atas dan ke bawah. Jika mouse yang digunakan memiliki roda scroll, 

tombol mouse ini juga dapat digunakan untuk memperbesar dan memperkecil 

tampilan peta. 

http://www.openoffice.org/
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 Menggeser Peta dilakukan dengan cara klik dan geser (tanpa mengangkat tombol 

kiri mouse) peta menuju lokasi yang baru. 

Begitu peta tersebut sudah berada pada posisi yang diinginkan, klik kanan dan pilih ‘Copy map 

coordinates’. Pada StatPlanet_data_editor.xlsm (dibuka menggunakan MS Excel), masuk ke 

sheet ‘Map regions’, pilih cell dibawah ‘X’ (pada kolom X) dan pindahkan nilai koordinatnya 

kesini. 

Label Teks: 

1. Memunculkan label teks pada peta adalah dengan klik ‘Show text labels’ pada 

StatPlanet_data_editor.xlsm yang dibuka menggunakan MS Excel (sheetΩ Import’, 

dibagian bawah tombol Save). 

2. Klik tombol ‘Save data’ pada StatPlanet_data_editor.xlsm ini, lalu buka StatPlanet lagi 

untuk melihat hasilnya. Kemungkinan posisi sebagian atau semua label teks masih perlu 

diatur lagi. 

3. Untuk mengatur posisi teks, klik kanan dimanapun pada StatPlanet dan pilih ‘Move text 

labels or map points’ pada bagian menu. Klik pada label teks untuk menggeser ke posisi 

yang baru. 

4. Begitu selesai memindahkan label teks, klik kanan dan pilih ‘Copy text label 

coordinates’ pada bagian menu. 

5. Buka StatPlanet_data_editor.xlsm, masuk ke sheet ‘Setting’. Pilih cell setelah ‘Text label 

coordinates’, dan pindahkan koordinat itu ke sini. (Dari sheet ini dapat juga dilakukan 

pengaturan yang lain, seperti ukuran teks huruf). 

6. Klik ‘Save settings’ (atau bisa juga klik ‘Save data’ pada sheet ‘Import’). Koordinat-

koordinatnya akan digunakan saat membuka StatPlanet lagi. 

7. Pada sheet ‘Setting’ , juga dapat digunakan untuk pengaturan tambahan, seperti ukuran 

huruf untuk label teks. 

Mencari peta 

Berikut ini adalah website-website yang berguna untuk mendapatkan shapefile secara gratis 

(batas regional/administratif). Catatan bahwa yang diperlukan adalah file batas dalam format 

“.SHP”. 

 Map Library – http://www.maplibrary.org/ - Peta publik bagi sebagian besar negara 

di dunia. Peta-peta ini tidak dijamin bebas dari kesalahan atau tidak dijamin menjadi 

peta yang terbaru. 

http://www.maplibrary.org/
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 UN SALB – http://unsalb.org/ - Proyek data Second Administrative Level Boundaries. 

Peta-peta disini adalah gratis, tetapi hak penggunaannya ada pada PBB. Peta-peta 

sudah divalidasi oleh Agensi Pemetaan Nasional dari tiap-tiap anggota PBB. 

 US Census Bureau – http://census.gov/geo/www/cob/bdy_files.html - File-file batas 

kartografis dari County dan District di Amerika Serikat. 

 ArcGIS map resources – http://resource.arcgis.com/content/data-maps/10.0/world 

 Stanford University map resources – http://www-

sul.stanford.edu/depts/gis/web.html 

Instruksi untuk menggunakan shapefile tanpa Excel 

1. Meng-copy shapefile seperti yang dijelaskan diatas 

2. Copy dan Paste ID negara dari file map.dbf menggantikan yang sudah ada pada file 

data.csv 

3. Copy dan Paste nama negara dari map.dbf menggantikan yang ada dibagian bawah 

pada file settings.csv 

4. Copy nama kolom ID, dan Paste di sebelah ‘DBF-ID’ pada file setting.csv 

Catatan: Kolom ID mungkin tidak berisi karakter spasi atau simbol, dan mestinya hanya 

memiliki nilai-nilai yang unik. 

Source Code GIS Shapefile Reader 

Source Code untuk perangkat lunak pembaca shapefile dimasukan pada direktori SHPreader. 

Source Code ini dapat dikompil (compile) menjadi SHPreader.swf yang dapat dibaca oleh 

StatPlanet. 

Kode ini ditulis oleh Edwin van Rijkom dibawah lisensi LGPL, dengan beberapa tambahan oleh 

Andy Woodruff, dan sedikit modifikasi untuk penggunaan dalam StatPlanet. 

Jika akan merubah nama peta yang dibaca, dapat dilakukan pada SHPreader.as dan 

mempublisnya sebagai SHPreader.swf melalui SHPreader.fla. 

Untuk informasi lebih jauh dapat dilihat pada http://shp.riaforge.org 

4.2. Membuat peta menggunakan Adobe Flash 

Untuk membuat peta interaktif sendiri yang akan digunakan pada StatPlanet, membutuhkan 

hal-hal berikut ini: 

 StatPlanet atau StatPlanet Plus 

http://unsalb.org/
http://census.gov/geo/www/cob/bdy_files.html
http://resource.arcgis.com/content/data-maps/10.0/world
http://www-sul.stanford.edu/depts/gis/web.html
http://www-sul.stanford.edu/depts/gis/web.html
http://shp.riaforge.org/
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 Adobe Flash CS3 atau yang lebih tinggi 

 Peta format vektor, bisa berupa Adobe Iiilustrator (.ai), Freehand (.fh*,.ft*), atau Adobe 

Flash (.swf) 

(Juga lihat: Mengubah gambar menjadi format vektor yang sesuai di Lampiran 3) 

Untuk membuat peta Flash, silahkan lihat tutorial di http://www.statsilk.com/maps/create-

flash-maps atau bisa juga dilihat pada Lampiran 1. 

  

http://www.statsilk.com/maps/create-flash-maps
http://www.statsilk.com/maps/create-flash-maps
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5. IMPOR ATAU MENAMBAH DATA 

5.1. Langkah dasar untuk penambahan data 

Berikut ini contoh untuk mengimpor data pada level negara ke dalam StatPlanet – versi “world 

map”. Bagaimanapun juga, proses ini sama juga bagi peta-peta lain, demikian pula untuk 

mengimpor ke dalam StatTrends. 

 

1. 

 

Download Unduh StatPlanet Map Maker dan ekstrak ke dalam komputer 

2. 

 

Open Pada folder ‘World_Map’, buka StatPlanet_data_editor.xlsm. 
Pastikan bahwa macros dalam keadaan aktif. Tekan tombol ‘Clear 
data’ untuk menghapus data contoh 

3. 

 

Import Tekan tombol ‘Import data’ dan pilih file yang berisi data yang 
akan diimpor. Data dapat juga dimasukan secara manual 
menggunakan program spreadsheet 

4. 

 

Save Tekan tombol ‘Save data’. Ini akan menyimpan data menjadi file 
data.csv. 

5. 

 

View Klik StatPlanet.exe  untuk melihat hasilnya 

6. 

 

Publish  Copy isi folder 'Web' ke dalam website kita untuk mempublis 
secara online. 

 

 

Untuk mempublikasikan StatPlanet secara online, yang dibutuhkan hanyalah mengunggah 

(upload) isi dari folder ‘Web’ ke dalam website (web server). Folder ini berisi: 

 StatPlanet.html – (halaman web yang menampilkan peta interaktif) 

 StatPlanet_small.html – (alternatif lain dengan peta yang lebih kecil untuk dimasukan 

dalam halaman web) 

 StatPlanet.swf – (file yang menampilkan proses loading) 

 content.swf – (program aslinya) 

 setting.csv – (pengaturan dalam format comma-separated value) 

 data.csv – (data dalam format comma-separated value) 

http://www.sacmeq.org/statplanet/files/StatPlanet_Map_Maker.zip
http://edutube.org/video/how-unzip-extract-files
http://www.sacmeq.org/statplanet/StatPlanet-Map-Maker.html#enablemacros
http://www.sacmeq.org/statplanet/StatPlanet-Map-Maker.html#import
http://www.sacmeq.org/statplanet/StatPlanet-Map-Maker.html#manual
http://www.sacmeq.org/statplanet/StatPlanet-Map-Maker.html#publish
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 swfobject.js – dibutuhkan untuk menjalankan isi file ‘Flash’ 

Mengaktifkan macros di Excel: 

 

5.2. Mengimpor data 

Dengan menggunakan StatPlanet_data_editor.xlsm, mengimpor data secara otomatis bisa 

dilakukan. Data Editor berbasis pada Excel, jadi akan banyak format data yang bisa diimpor 

(termasuk CSV, TXT, XLS, XLSX, DBF dan HTML). 

StatPlanet_data_editor.xlsm secara otomatis akan mengenali struktur data dari file yang akan 

diimpor dan juga mengenali berbagai kemungkinan variasi nama negara yang umum secara luas 

(menurut peta dunia versi StatPlanet). Proses impor semestinya dapat berhasil tanpa perlu 

banyak perubahan pada file data. Jika ada masalah, dapat dilihat pada bagian ‘Troubleshooting’ 

dibawah ini. 

StatPlanet_data_editor.xlsm menggunakan  nama-nama pada Excel di sheet ‘Import names’ dan 

mencari hubungan antara nama-nama dengan statistik pada file data (pada versi peta dunia, 

sheet ini berisi nama wilayah/negara, tetapi dapat juga berisi nama provinsi atau kabupaten, 

tergantung penggunaan peta). StatPlanet_data_editor.xlsm otomatis akan merestrukturisasi 

data pada format yang dapat digunakan oleh StatPlanet. 

Pada membuka StatPlanet_Data_Editor.xlsm biasanya akan muncul pesan yang menanyakan 

agar mengaktifkan macros (enable macros). Bentuk pesannya tergantung dari versi program 

Excel-nya. 

Excel 2007 atau yang lebih baru: Pada bagian atas layar, disebelah ‘Security Warning’, klik 

tombol ‘Option’. Pilih ‘Enable this content’ dan klik ‘OK’. 

Excel versi yang sebelumnya: Pilih ‘Enable Macros’ pada window popup.   

Jika tidak ada pesan seperti diatas yang muncul, batas keamanan macro diatur pada nilai ‘high’ 

(tinggi). Ikutilah instruksi berikut untuk menurunkan batas keamanan. 

 Excel 2007 atau yang lebih baru: Klik tombol Microsoft Office (kiri-atas) dan klik ‘Excel 

Options’. Pada kategori ‘Popular’, berilah tanda centang pada ‘Show Developer tab in the 

Ribbon’ (jika belum tercentang). Klik ‘OK’, lalu pilih tab ‘Developer’. Klik pada ‘Macro 

security’ (sebelah kiri). Pilih ‘Disable all macros with notification’. 

Excel versi yang sebelumnya: Melalui menu ‘Tools’, masuk ke Macro > Security. Ubahlah batas 

keamanannya menjadi ‘Medium’. 
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Kriteria keberhasilan impor adalah nama wilayah/negara harus hanya muncul sekali pada file 

data yang diimpor. Juga perlu dicatat bahwa StatPlanet akan membaca tanda ‘titik’ sebagai 

pemisah desimal (koma). 

Mengimpor file HTML atau PDF 

 HTML: untuk mengimpor data dari halaman web, hanya tinggal menyimpan halaman 

web tersebut dan impor seperti file lain. Jika proses impor gagal, mungkin karena nama 

negara dan statistiknya terlalu jauh kebawah. Jika ini terjadi, buka file tersebut 

menggunakan Excel dan hapus baris sampai ditempat dimana baris data dimulai. Lalu 

impor sekali lagi. Cara lain, copy dan paste tabel dari halaman web ke dalam file excel 

yang baru. 

 PDF: Tabel pada file PDF biasanya bisa langsung di-copy dan paste ke dalam file Excel. 

Pilihlah tabel menggunakan mouse, klik kanan dan pilih ‘Copy as Table’ atau ‘Save as 

Table’ from the menu. Lihat juga petunjuk yang cukup membantu dari McGill University:  

http://www.library.mcgill.ca/edrs/services/publications/howto/pdftoxls/pdftoexcel.html 

ada juga tool gratis untuk mengubah file PDF menjadi Excel: 

http://www.pdftoexcelonline.com 

Nama tidak dikenali 

Nama peta regional di dalam file data yang tidak dikenali akan ditampilkan begitu proses impor 

selesai. Contohnya, bila di dalam file data negara ‘Afganistan’ ditandai dengan singkatan ‘Afg’, 

lalu singkatan ini tidak dikenali oleh data editor. Untuk memperbaiki kesalahan ini, buka file 

Excel pada sheet ‘Import names’ dan tambahkan ‘Afg’ pada cell yang kosong dibawah nama 

negara yang merupakan kepanjangannya ‘Afganistan’. Cara yang sama dapat digunakan juga 

untuk menemukan kekeliruan, yaitu proses impor melalui macros dilakukan untuk 

mengidentifikasi data yang belum benar. Kemudian impor sekali yang sudah menggunakan data 

yang benar. 

Perlu dicatat bahwa macros impor disini menghapus spasi pada sheet ‘Import names’ dan 

mengganti karakter-karakter khusus (seperti ê) menjadi karakter umum (misalnya e) selama 

proses impor. Hal ini memungkinkan agar penyebutan nama negara dapat dideteksi secara 

lebih luas. Penggunaan huruf besar ataupun huruf kecil pada nama-nama negara ini tidak 

berpengaruh. Pada versi Peta Dunia mengenali penyebutan nama negara dalam bahasa Inggris 

dan Perancis dan juga sejumlah variasi lain untuk penyebutan-penyebutan ini. Impor data 

secara otomatis ini sudah berhasil dilakukan uji coba pada beberapa sumber data yang memiliki 

struktur data dan variasi nama negara yang berbeda, termasuk itu pada CIA Factbook, 

http://www.library.mcgill.ca/edrs/services/publications/howto/pdftoxls/pdftoexcel.html
http://www.pdftoexcelonline.com/


22 

Ethnologue, IMF, ITU, Nation Master, OECD, UBS, UIS, UNAIDS, UNDP, UNESCO, UNICEF, 

UNSTATS, WHO dan Bank Dunia (World Bank). 

Data Editor terdaftar sebagai Proyek Open Source pada SourceForge dan kontribusi atau 

perbaikan terhadap perangkat lunak ini adalah boleh dilakukan.  

(http://sourceforge.net/projects/statplaneteditr/). 

5.3. Troubleshooting 

Jika data yang sudah disimpan ternyata tidak dapat dibaca oleh StatPlanet, kemungkinan besar 

masalahnya adalah pada struktur data. Perhatikan pada nomor 4 dibawah ini untuk membuat 

struktur data berdasarkan tahun (atau waktu lainnya). Data seharusnya diawali dari urutan 

waktu yang paling baru. Juga pastikan bahwa daftar indikator untuk tiap tahunnya benar-benar 

sama dan sesuai urutan yang sama. 

Jika proses impor gagal, periksalah file data dari kemungkinan sebagai: 

1. Penulisan nama 

Jika penulisan nama negara/peta/regional tidak dapat diidentifikasi, data yang 

terhubung tidak dapat diimpor. Lihatlah pada bagian “Nama tidak dikenali” diatas untuk 

informasi lebih jauh dan bagaimana memperbaikinya. 

2. Nama muncul lebih dari sekali 

Jika nama negara/peta/regional muncul lebih dari satu kali di dalam file data, macro 

hanya akan mengimpor data yang terhubung dengan nama yang pertama. 

Struktur berikut ini tidak dapat diimpor dengan benar: 

Negara Dimensi Tinggi Sedang Rendah 

Afghanistan A 6 3 2 

 B 7 5 2 

Albania A 9 6 3 

 B 12 5 2 

Aljazair A 11 5 1 

 B 21 11 9 

Andorra A 15 14 12 

 B 14 11 10 

 

http://sourceforge.net/projects/statplaneteditr/
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Struktur seperti ini perlu diperbaiki yaitu satu nama negara/peta/regional untuk tiap 

satu baris, seperti yang ditunjukan diberikut ini (alternatif lain, pada kasus tertentu 

mungkin lebih mudah untuk membagi data menjadi beberapa file dan mengimpornya 

secara terpisah) 

Struktur seperti ini dapat diimpor dengan benar: 

 Negara A-Tinggi A-Sedang A-Rendah B-Tinggi B-Sedang B-Rendah 

Afghanistan 6 3 2 7 5 2 

Albania 9 6 3 12 5 2 

Aljazair 11 5 1 21 11 9 

Andorra 15 14 12 14 11 10 

3. Tidak ada indikasi adanya data tahun pada file atau tidak terdeteksi 

Semua indikator disusun menurut tahun. Perlu penambahan data tahun sebagai judul 

baris atau kolom (tergantung dari struktur datanya). Cara lain adalah dengan 

mengimpor datanya, lalu menambahkan tahunnya kemudian. Data harus disusun 

sebagai berikut (contohnya adalah struktur dari sampel data pada 

StatPlanet_data_editor.xlsm): 

 Kelompokan (urutkan) indikator berdasarkan tahun. Masukan baris baru diatas 

tiap kelompok indikator. Pada baris baru ini tambahkan tahun pada kolom 

‘TAHUN’. Biarkan cell pada kolom ‘INDIKATOR’ tetap kosong; 

 Perhatikan bahwa pada kolom ‘TAHUN’ cell yang bersebelahan dengan indikator 

harus kosong. 

TAHUN INDIKATOR 

2001  

 Indikator1 

 Indikator2 

2000  

 Indikator1 

 Indikator2 

4. Tanda Titik Desimal 

StatPlanet membaca tanda titik sebagai tanda pemisah desimal (contoh 0.75). Jangan 

gunakan tanda koma, spasi atau simbol-simbol bilangan lain agar data dapat dibaca 

dengan benar oleh StatPlanet. 

  



24 

6. PERUBAHAN TAMPILAN 

6.1. Pengaturan umum dan perubahan tampilan 

Pengaturan umum untuk merubah tampilan (customizing) program StatPlanet tersimpan di file 

‘StatPlanet_data_editor.xlsm’ pada sheet ‘Settings’. Setelah selesai melakukan perubahan 

dibagian pengaturan ini, tekan tombol ‘Save Settings’. Pengujian pengaturan dapat dilakukan 

secara langsung pada StatPlanet melalui panel ‘General Options’ dan panel ‘Map Legend 

Option’. 

Di dalam file Excel pada sheet ‘Settings’, berbagai pengaturan yang dapat diedit diberi tanda 

warna kuning pada cell di kolom C. Ada beberapa tanda centang  dan menu drop-down di 

kolom D yang juga dapat digunakan untuk memudahkan perubahan pengaturan nilai pada cell 

yang bersangkutan di kolom C. (contohnya, klik tanda centang untuk merubah nilai dari ‘TRUE’ 

menjadi ‘FALSE’). 

Pada bagian selanjutnya dapat dilihat bagaimana melakukan perubahan tampilan StatPlanet 

untuk level indikator atau kategori (misalnya menentukan warna yang berbeda untuk indikator 

yang berbeda). 

Berikut ini adalah pengaturan yang mungkin memerlukan keterangan tambahan: 

 Memodifikasi peta, grafik atau warna tampilan 

Hampir semua pewarnaan yang digunakan pada StatPlanet dan diganti-ganti dan ada 

lebih dari 40 kelompok pewarnaan. Penambahan warna dapat dilakukan pada level 

indikator (untuk yang lebih detail dapat dilihat pada bagian selanjutnya). Pewarnaan 

dapat dibuat menggunakan kode warna hex (hexadecimal), yang berupa karakter ‘0x’ 

diikuti oleh enam digit atau karakter (misal 0xFFFFFF untuk warna putih). Kode hex ini 

dapat ditemukan pada perangkat lunak yang biasanya untuk desain seperti Adobe 

Dreamweaver.  Warna dan hubungannya dengan kode hex juga biasanya ditemukan 

secara online. 

 Show/hide interface components (Menampilkan/menghilangkan komponen tampilan) 

Gunakanlah pengaturan dibagian ini untuk menampilkan atau menghilangkan berbagai 

panel, icon dan komponen-komponen lainnya untuk mengganti tampilan StatPlanet 
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 View menu option (Pengaturan menu tampilan) 

View menu option disini identik dengan pengaturan tampilan pada StatPlanet, yang 

dimuncul dengan meng-klik icon ‘View’ dikiri-bawah layar. 

 Menambahkan label teks dan posisinya pada peta 

Silahkan melihat pada bagian penyusunan peta buatan sendiri (bisa pada di bagian 

mengimpor peta shapefile ESRI atau bagian menggunakan template peta flash) 

 Menambahkan judul peta 

Dibawah ‘Map options’, ‘MAP-TITLE’, masukan teks sebagai judul peta. Cara untuk 

menempatkan judul peta sama dengan cara untuk menempatkan teks lainnya pada 

peta: (i) klik kanan dimanapun di dalam peta dan pilih ‘Move text labels or map points’ 

pada bagian menu; (ii) geser judul peta ke posisi baru; (iii) klik kanan dan pilih ‘Copy text 

label coordinate’ dibagian menu; (iv) pada StatPlanet Data Editor, masuk ke sheet 

‘Settings’. Klik pada cell disebelah ‘Text label coordinates’, dan masukan nilai 

koordinatnya ke sini. 

 Peta tumpukan layer 

Peta yang terdiri dari tumpukan layer dapat dilakukan pada peta flash maupun peta 

versi shapefile-nya StatPlanet. Sebagai contoh implementasi tumpukan layer, dapat 

dilihat pada Lampiran 2 atau http://www.statsilk.com/maps/create-flash-maps#multiple-map-

layers 

6.2 Perubahan tampilan pada level kategori & 

indikator 

Pada StatPlanet_data_editor.xlsm, ada beberapa kolom yang digunakan untuk menentukan 

parameter pilihan. Perbedaan kolom dan penggunaannya dijelaskan sebagai berikut. 

 

 Sumber data 

Sumber untuk data dapat ditentukan pada setiap indikator atau untuk semua indikator 

pada suatu kategori (pada StatPlanet Plus, data dapat disusun dalam kategori dan sub-

PENTING: PERUBAHAN TAMPILAN, SEPERTI DESKRIPSI INDIKATOR, HARUS HANYA 

DIKHUSUSKAN BAGI INDIKATOR-INDIKATOR PADA TAHUN PERTAMA (ATAU YANG TERATAS). 

DESKRIPSI INDIKATOR TIDAK PERLU DIULANG-ULANG SETIAP TAHUN PADA SERI TERSEBUT. 

http://www.statsilk.com/maps/create-flash-maps#multiple-map-layers
http://www.statsilk.com/maps/create-flash-maps#multiple-map-layers
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kategori). Sumber data ditentukan pada kolom “SOURCE”. Untuk menentukan sumber 

abgi semua kategori, masukan sumber pada kolom pertama dari kategori (pada baris 

yang sama dengan tahun pertama pada seri tersebut). Sedangkan untuk menentukan 

sumber bagi indikator, masukan sumber tersebut pada baris yang sama dengan 

indikator.  

Kode HTML dapat ditambahkan sebagai link ke website sumber data, dengan format 

sebagai berikut: 

<a href=’http://www.sumberdata.com’>Sumber Data</a> 

Penting dicatat: 

o Pada kode HTML diatas, hanya menggunakan sepasang tanda kutip (‘ ’), dan 

bukannya dobel tanda kutip (“ “). 

o Link ini tidak dapat digunakan jika menjalankan web versi offline (platform Flash 

tidak mengijinkan proses ini untuk alasan keamanan). Link hanya dapat digunakan 

pada saat file-file tersebut online. Jika bermaksud menggunakan atau menguji link-

link tersebut secara offline, gunakanlah versi desktop.  

 Satuan (Unit) dan deskripsi indikator 

o Deskripsi: Tambahkan deskripsi di tiap indikator pada kolom ini, yang akan 

ditampilkan sebagai popup pada StatPlanet saat menggerakan mouse melewati 

indikator tersebut. 

o Satuan: Tambahkan satuan untuk indikatornya, misalnya ‘%’ 

o Seperti dijelaskan sebelumnya, ini hanya perlu ditambahkan ke dalam daftar 

indikator  dibawah tahun pertama pada seri yang bersangkutan. Jika ada dua atau 

lebih indikator dengan deskripsi yang sama, hanya perlu memasukan deskripsi satu 

kali saja. Untuk indikator yang lain, sebagai gantinya menggunakan deskripsi yang 

ada di dalam file Excel (StatPlanet_data_editor.xlsm sheet ‘Import’) dimana deskripsi 

yang ingin digunakan lagi berada. 

 Legenda peta, label dan pewarnaan 

Pada bagian ini, tampilan legenda untuk tiap indikator dapat diubah. Juga dapat 

dilakukan perubahan nilai-nilai legenda peta (bisa teks atau angka), pewarnaan dan juga 

jumlah warna pada kategori. 

Tampilan legenda peta dapat diatur ulang di dalam StatPlanet itu sendiri, lalu copy dan 

paste ke dalam file data. Pada StatPlanet, tentukan indikator yang akan diubah 
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tampilannya pada legenda peta. Kemudian klik pada sembarang warna atau nilai di 

dalam panel legenda peta di sudut kiri-bawah untuk mengubah tampilan petanya. Jika 

sudah merasa cukup dengan legenda peta yang baru saja diatur ulang, klik kanan 

dimanapun di dalam StatPlanet dan pilih ‘Copy map legend’ dari menu. Buka file 

StatPlanet_data_editor.xlsm. Klik pada cell dibawah nama kolom ‘MAP’, pada baris yang 

berhubungan dengan indikator (dimana pengaturan tampilan legenda dilakukan). Pilih 

Paste untuk memasukan legenda yang diatur tampilannya. Bila ada data untuk 

serangkaian tahun, hanya perlu ‘Paste’ pada baris di tahun pertama pada seri tersebut. 

Klik ‘Save data’ untuk melihat hasilnya saat membuka StatPlanet. 

Lebih jauh mengenai re-desain legenda peta, termasuk bagaimana membuat peta 

kualitatif, diuraikan berikut ini. Bila ingin membuat legenda peta kualitatif (berdasarkan 

kategori misalnya ‘tinggi’, ’sedang’, ‘rendah’), daripada legenda kuantitatif (berdasarkan 

nilai numerik), maka perlu mengikuti pendekatan pada poin (iv) dan (v) dibawah ini. 

(i) Legenda Peta dengan nilai yang diatur 

Á Gunakanlah format berikut ini untuk mengatur nilai pada legenda, demikian 

juga untuk jumlah kelas warna 

0=[nilai0] 1=[nilai1] 2=[nilai2] 3=[nilai] 4=[nilai4] dst. 

Á Contoh 1a: Legenda dengan 4 kelas warna: 

0=[55] 1=[40] 2=[20] 

Á Contoh 1b: Legenda dengan 5 kelas warna: 

0=[70] 1=[65] 2=[60] 3=[55] 

Legenda peta untuk contoh 1b 

Dengan nilai max/min 

tersebunyi 

Dengan nilai 

max/min tampil 

> 70 70 – nilai max 

65 – 70 65 – 70 

60 – 65 60 – 65 

55 – 60 55 – 60 

< 55 Nilai min - 55 
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(ii) Legenda Peta dengan warna yang diatur 

Á Gunakanlah format berikut ini untuk mengatur warna pada legenda, 

demikian pula jumlah kelas warnanya: 

0=[warna0] 1=[warna1] 2=[warna2] 3=[warna3] 4=[warna4] dst 

Á Contoh 2: Legenda dengan 4 kelas warna: 

0=[0x238B45] 1=[0x66C2A4] 2=[0xB2E2E2] 3=[0xEDF8FB] 

(iii) Legenda Peta dengan warna dan nilai yang diatur 

Á Gunakanlah format berikut ini untuk mengatur warna pada legenda, dan juga 

jumlah kelas warnanya: 

0=[warna0][nilai0] 1=[warna1][nilai1] 2=[warna2][nilai2] 3=[warna3][nilai3] 

4=[warna4] 

Perhatikan bahwa format ini sedikit berbeda dari sebelumnya, sebab 5 warna 

ditentukan (warna 0 sampai 4) tetapi hanya 4 nilai (nilai 0 sampai 3). Seperti 

digambarkan pada contoh 1b diatas, legenda dengan 5 kelas warna hanya 

memerlukan 4 nilai yang perlu ditentukan (legenda dengan 4 kelas warna 

hanya memerlukan 3 nilai dan seterusnya). 

Á Contoh 3: Legenda dengan 4 kelas warna dan nilai tertentu: 

0=[0x2171B5][70] 1=[0x6BAED6][60] 2=[0xBDD7E7][50] 3=[0xEFF3FF] 

(iv) Legenda Peta dengan warna dan label yang diatur 

Á Untuk memasukan label teks (bukannya nilai numerik) pada legenda peta, 

menggunakan cara yang sama seperti pada bagian (iii) diatas, tetapi 

ditambah parameter ketiga yang berisi teks. Contohnya: 

Á Contoh 4: Legenda dengan 4 kelas warna, nilai tertentu dan label tertentu: 

0=[0x2171B5][70][Sangat Tinggi] 1=[0x6BAED6][60][Tinggi] 

2=[0xBDD7E7][50][Sedang] 3=[0xEFF3FF][Rendah] 

(v) Legenda Peta Kualitatif (deskriptif) 

Á Jika data set berupa kategorikal, misalnya bahasa yang digunakan di dunia 

(Bahasa Inggris, Spanyol dll), maka membutuhkan legenda peta kualitatif. 

Tidak seperti jangkauan nilai, legenda peta menetapkan angka kategori untuk 

tiap kategori yang akan ditampilkan, diawali dari 0. Pada contoh dibawah ini, 

ditentukan 5 kategori (0, 1, 2, 3, 4): 
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0=[warna0][label0] 1=[warna1][label1] 2=[warna2][label2] 

3=[warna3][label3] 4=[warna4][label4] dst. 

Nama-nama negara ini kemudian harus ditetapkan pengaitnya dengan angka 

kategori. Sebagai contoh ‘Afghanistan’ memiliki kategori 0 (label 0 dan warna 

0), maka harus diberi nilai ‘0’. 

Á Contoh 5: Legenda dengan 8 kelas warna: 

0=[0x377EB8][Arab] 1=[0xE41A1C][Bengali] 2=[0x4DAF4A][Inggris] 

3=[0x984EA3][Hindi] 4=[0xFF7F00][Mandarin] 5=[0xFFFF33][Portugis] 

6=[0xA65628][Rusia] 7=[0xF781BF][Spanyol] 

Á Legenda contoh 5: 

Warna Label 

0x377EB8 Arab 

0xE41A1C Bengali 

0x4DAF4A Inggris 

0x984EA3 Hindi 

0xFF7F00 Mandarin 

0xFFFF33 Portugis 

0xA65628 Rusia 

0xF781BF Spanyol 

 

 Pengaturan grafik 

(i) Jangkauan sumbu grafik 

Untuk menggunakan nilai maksimum dan minimum sesuai keinginan kita sendiri, nilai-

nilai ini dapat dimasukan melalui kolom ‘GRAPH’. Cantumkan nilai minimum/maksimum 

secara berpasangan dengan format: [nilai-min][nilai-maks] 

Sebagai contoh, untuk nilai minimal 0 dan nilai maksimum adalah 80, penulisannya 

sebagai berikut: 

[0][80] 

Juga dapat disertakan warna dari grafik tersebut dengan format [kode-warna], 

contohnya: 

[0x78C679] 
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Penulisan nilai minimum/maksimum dan juga warnanya, menggunakan format [nilai-

min][nilai-maks][kode-warna], contohnya: 

[0][90][0x78C679] 

(ii) Garis target (Hanya pada StatPlanet Plus/StatTrends Plus) 

Satu atau dua garis target (atau benchmark) dapat ditentukan untuk tiap indikator, yang 

kemudian ditampilkan pada diagram batang/kolom dan grafik time series. Untuk ini 

perlu dimasukan pada kolom ‘GRAPH’ (pada baris yang sama dengan indikatornya). 

Contoh untuk dua garis target (t dan t2) dengan nilai 80 dan 50 ditunjuk dibawah ini: 

t=[80] t2=[50] 

Label (l dan l2) dan warna yang sesuai keinginan (c dan c2) dapat juga ditambahkan: 

 t=[80] t2=[50] l=[Target1] l2=[Target2] c=[0x1a9850] c2=[0xd73027] 

 Menggunakan banyak file data  

(Hanya untuk StatPlanet Plus/StatTrends) Data dapat dibagi menjadi beberapa file, yang 

sesungguhnya berguna untuk mengurangi waktu awal pengunduhan (download) dan 

hanya mengunduh data untuk kategori yang diinginkan pengguna. File data ‘utama’ 

(data.csv atau data.zip) berisi link-link ke file data yang lainnya. File ini tidak perlu berisi 

data apapun, tetapi harus berisi struktur untuk semua file data yang disatukan. 

Terutama sekali, file ini harus memiliki daftar keseluruhan kategori dan juga indikator 

yang datanya tersimpan pada file-file yang digabungkan tadi. Ini karena daftar kategori 

dan indikator harus tersedia saat program pertama kali dijalankan, meski tanpa perlu 

mengambil salah satu file datanya. Untuk tiap kategori hanya satu satuan waktu (atau 

dalam satuan tahun) dari seri data tersebut yang perlu diisikan ke dalam struktur (jadi 

tidak perlu mengulang-ulang daftar indikator setiap tahunnya). 

Untuk menghubungkan dengan file data yang berisi data suatu kategori, harus 

ditentukan pada baris pertama (teratas) untuk kategori ini dibagian kolom “FILE”. 

Contohnya, bisa saja berisi file referensi “data_category2.csv” atau 

“data_category2.zip”. Baris-baris lain pada file data utama yang tidak berisi data (yaitu 

data akan diambil dari file yang lain) perlu dimasukan simbol # pada kolom ‘FILE’. 

Contoh lagi, jika semua data berada pada file-file yang lain, kolom ‘FILE’ akan berisi 

referensi untuk file-file ini pada baris pertama untuk setiap kategori. Semua baris 

sisanya pada kolom ‘FILE’ akan berisi simbol #. 
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File-file yang berisi data harus benar-benar mengikuti struktur yang sama dengan file 

data yang sebenarnya, kecuali jika hanya berisi data untuk satu kategori saja. 

 Pengaturan 

Berbagai pilihan dapat ditambahkan dengan memasukan spasi pemisah diantara 

pilihan-pilihan itu, misalnya: 

y=[2007] nodiv 

o Default tahun menurut kategori: Tahun default yang dipilih untuk kategori 

tertentu dapat ditentukan pada kolom ‘OPTIONS’. Untuk StatPlanet Plus, perlu 

dimasukan pada baris yang sama dengan nama kategori. Untuk versiStatPlanet 

yang lain, dimasukan pada baris pertama data di dalam 

StatPlanet_data_editor.xlsm. Formatnya seharusnya ‘y=*tahun+’, contohnya: 

y=[2007] 

o Grup indikator dalam kategori: Kategori suatu indikator dapat ditempatkan ke 

dalam grup-grup yang berbeda pada suatu kategori. Dengan mengaktifkan 

pilihan ini, tombol radio akan tampak diatas daftar indikator untuk menjalankan 

pilihan grup. Hanya indikator yang sedang dipilih dalam gruplah yang akan 

ditampilkan. 

Agar pembagian grup bisa dilakukan, berikut ini harus dimasukan pada baris 

teratas (pertama) dari kategori, pada kolom ‘OPTIONS’: 

g=[grup1, grup2, grup3, dll.]  

Grup1, grup2, dll. Diganti dengan nama-nama grup yang diinginkan dan akan 

ditampilkan sebagai tombol radio (bisa dimasukan sampai 5 grup). Sebagai 

contoh, indikator dapat dibagi menjadi grup ‘Total’, ‘Pria’, ‘Wanita’ seperti 

berikut ini: 

g=[Total, Wanita, Pria] 

Agar supaya perangkat lunak mengetahui indikator mana yang menjadi milik 

grup tertentu, nama grup harus muncul juga pada nama indikator. Sebagai 

contoh indikator ‘Pendaftar Sekolah Utama Wanita’ otomatis akan muncul dalam 

grup ‘Wanita’. 

o Tidak ada Pembagian (No Division): Secara default-nya jika suatu indikator 

memiliki angka yang mencapai lebih dari satu juta, akan dibagi dengan 1000 000 
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dan kata “milion” (juta) akan ditambahkan sebagai satuan. Agar keadaan ini tidak 

terjadi pada indikator tertentu, masukanlah teks berikut pada kolom ‘OPTIONS’ 

dibaris indikator pada tahun pertama di seri tersebut: 

nodiv 

o Menyembunyikan kategori ‘no data’ pada legenda: untuk menyembunyikan 

kategori ‘no data’ masukan kode dibawah ini pada kolom ‘OPTIONS’ pada baris 

indikator untuk tahun pertama pada seri tersebut. 

nd=[h] 

o Mengganti regional: Penggantian regional jika sedang memilih kategori tertentu 

dimana hanya memiliki data untuk regional itu sering kali bermanfaat juga. 

Untuk bisa melakukan ini, tentukan nama regional pada kolom ‘OPTIONS’, di 

baris pertama kategori tersebut. Formatnya haruslah seperti ini: 

r=*nama_regional+. “nama_regional” harus berkaitan dengan dengan salah satu 

dari peta regional yang dicantumkan di dalam StatPlanet_data_editor.xlsm, pada 

sheet ‘Map regions’. Contohnya: 

r=[Sub-Saharan Africa] 

o Ukuran diagram panel indikator: Diagram yang ditampilkan pada panel indikator 

ukurannya menyesuaikan terhadap nilai tertinggi  data dari negara atau wilayah 

pada indikator tersebut. Artinya tiap indikator akan memiliki skala tersendiri. 

Terkadang kita juga menginginkan diagram-diagram ini untuk semua indikator 

menggunakan skala yang sama. Untuk ini, masukan tulisan berikut ini pada 

kolom ‘OPTIONS’, dibaris indikator yang akan disamakan skalanya:  

samescale 

Perhatikan bahwa tulisan diatas harus dimasukan pada baris untuk tahun 

pertama di seri yang bersangkutan, dan bahwa indikator tersebut harus pada 

kategori yang sama. 

 Tipe data 

Kolom ‘TYPE’ difungsikan untuk menentukan tipe data pada versi StatPlanet selanjutnya. 

Hal demikian akan memungkinkan penambahan antarmuka dan pilihan cara 

penampilan. 
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6.3. Teks popup nama negara/wilayah dan link 

Informasi khusus pada suatu negara/wilayah dapat ditampilkan dalam bentuk popup bila kursor 

mouse bergerak melewati negara/wilayah yang bersangkutan pada peta atau panel grafik. 

Informasi ini dapat ditambahkan pada baris pertama pada cell yang kosong dibawah nama 

negara/wilayah yang terhubungkan.2 (Cell-cell ini kosong, karena data negara dimulai pada baris 

selanjutnya). 

Teks yang ditambahkan dapat berupa teks murni atau HTML, teks yang terformat, contohnya: 

<font size=”15” color=”#347C17”>Ini teks</font> 

Link ke dokumen atau halaman web juga dapat disertakan pada baris dibawah nama negara 

yang terhubungkan. File dokumen atau halaman web akan terbuka ketika pengguna meng-klik 

pada negara yang sudah memiliki link yang ditentukan. Contoh sebuah link misalnya: 

http://www.websitesaya.com/dokumen.pdf 

Bisa juga berupa teks dan link unduhan, dengan menyertakan link tersebut dalam bentuk kode 

HTML, contohnya: 

<a href=’ http://www.websitesaya.com/dokumen.pdf’>Masukan informasi tambahan disini</a> 

6.4. Perbesar ke peta regional tertentu 

Nama regional tertentu dapat ditambahkan, dihapus atau diganti pada worksheet ‘Map 

regions’. Contohnya, pada peta dunia, wilayah regional itu adalah ‘Africa’. Klik ‘Africa’ pada 

menu drop-down pemilihan wilayah akan mengarahkan pada benua Afrika dan menampilkan 

peta dan grafik hanya untuk negara-negara Afrika. 

‘Map regions’ memiliki elemen-elemen: 

 Nama (kolom 1): Nama peta regional yang akan ditambahkan. Jika akan menyusun 

suatu kelompok regional menjadi sub-menu, masukan nama sub-menu seperti nama 

regional lainnya. Lalu untuk nama regional lanjutan dibawahnya, ditambahkan tanda ‘>’ 

bila ingin dimasukan di dalam sub-menu ini (prinsipnya sama dengan sistem 

pengelompokan indikator). Pada contoh berikut ini, “Sub-menu saya” adalah nama dari 

                                                      
2
 Catatan: Semestinya memang dibawah nama negara/wilayah pada sheet ‘import’ StatPlanet_data_editor.xlsm. 

Selain itu jika tidak menggunakan StatPlanet_data_editor.xlsm, informasi tersebut dapat dimasukan secara 

langsung pada file setting.csv dikolom sebelah nama negara/wilayah. 
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sub-menu yang dibuat, dan simbol ‘>’ digunakan untuk menentukan regional yang 

dimasukan dalam sub-menu ini: 

Regional 1 

Regional 2 

Sub-menu saya 

> Regional 3 (di dalam sub-menu) 

> Regional 4 (di dalam sub-menu) 

Regional 5 (tidak di dalam sub-menu) 

dst. 

 Koordinat peta (kolom 2 – 4): Koordinat X dan Y dan nilai perbesaran (ZOOM) bagi 

regional yang ditentukan. Untuk mendapatkan nilai koordinat ini, bukalah peta pada 

StatPlanet dan perbesar sampai wilayah yang ingin ditambahkan (misalnya perbesar 

sampai Afrika lalu klik dan geser peta sampai Afrika tampil penuh di layar). Begitu posisi 

peta sudah sesuai keinginan, klik kanan dimanapun pada StatPlanet dan pilih ‘Copy map 

coordinates’. Kembali ke file Excel sheet ‘Map regions’ dan paste koordinat tersebut 

pada baris mengenai regional tersebut. 

 Warna (kolom 5 – pilihan): Warna untuk tiap regional yang akan dipakai sebagai warna 

untuk lingkaran pada grafik scatter plot. Bisa juga warna diagram bar memakai warna 

dari regional ini. Warna untuk regional dituliskan dengan kode ‘hex’, seperti ‘0x0000FF’ 

untuk warna biru. 

 Link (kolom 6 – pilihan, hanya untuk StatPlanet Plus): Masukan sebuah link atau URL, 

misalnya untuk membuat link sebuah nama peta dengan copy lain dari StatPlanet 

dimana peta ini dilekatkan. Dapat juga fitur ini digunakan sebagai link pada dokumen 

untuk diunduh. 

 Kode (kolom 7 dan seterusnya): Kolom 7 dan seterusnya berisi kode negara atau area 

peta untuk tiap regional (disini yang tertera adalah kode negara ISO3 untuk peta dunia 

versi StatPlanet). Kode bagi tiap negara atau area peta ada dibaris paling atas di dalam 

sheet ‘Data’. Untuk menambah negara atau area peta pada regional tertentu, 

tambahkan kode pada kolom 7 tanpa menyisakan cell kosong diantaranya. 

6.5. Menambahkan kota, negara, pembagian 

regional, lokasi penting 

Kota, negara, pembagian regional dan lain-lain dapat ditambahkan ke dalam StatPlanet dan 

akan muncul pada grafik dan daftar negara/regional. Pada StatPlanet Plus, juga dapat 
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ditambahkan berupa ‘peta titik’ (misalnya ‘titik kota’ yang diletakan pada peta negara). 

Prosedurnya sebagai berikut: 

1. Buka StatPlanet_data_editor.xlsm dan pada sheet ‘Import’, menuju ke nama negara 

atau regional terakhir pada baris ke dua paling belakangan. 

2. Masukan nama peta titik pada baris ini dan tekan tombol ‘Save data’. Data dapat 

ditambahkan pada kolom ini dengan cara yang sama seperti menambahkan area peta 

lainnya. Akan dibutuhkan penambahan beberapa data dari peta titik ini supaya dapat 

tampil pada peta (Perhatikan: setelah menekan tombol ‘Save data’, nama peta titik 

seharusnya sudah ditambahkan juga ke dalam sheet ‘Data’. Bila peta titik tidak muncul 

di dalam StatPlanet, cek juga pada sheet ‘Data’ untuk meyakinkan bahwa nama peta 

titik juga sudah ditambahkan ke bagian ini. 

Hanya untuk StatPlanet Plus: 

3. Bila kemudian membuka StatPlanet, salah satu atau lebih peta titik (dalam bentuk 

lingkaran) akan muncul di sudut kiri-atas peta, menandakan setiap area peta baru yang 

sudah ditambahkan. Klik kanan dimanapun pada bagian peta dan pada popup pilihlah 

‘Move text label or map points’. Klik pada peta titik, kemudian lagi dimanapun pada 

layar untuk menggeser titik tersebut ke lokasi baru. Dengan cara yang hampir sama, 

label teks dari peta titik dapat digeser dan diletakan pada lokasi yang baru. 

4. Untuk meng-copy koordinat peta titik, klik kanan lagi dan pilih ‘Copy map point 

coordinates’. 

5. Buka StatPlanet_data_editor.xlsm dan masuk ke sheet ‘Settings’. Gulung layar ke 

‘Special options’ dan di sebelah M-DOT-COORD paste koordinat yang baru di-copy. Pada 

bagian ini juga dapat diatur ukuran lingkaran yang digambarkan oleh peta titik. Klik ‘Save 

settings’ untuk menyimpannya. 

6.6. Mengedit data tanpa Excel 

File data ‘data.csv’ dan ‘settings.csv’ dapat diedit secara langsung tanpa melalui program Editor 

Data dengan Excel. Dua file ini dapat diedit menggunakan program spreadsheet. 

Data harus disimpan dalam format CSV (comma separated value). 

6.7. Bahasa dan terjemahan 

Untuk mengubah bahasa, lihat sheet ‘Settings’ pada file StatPlane_data_editor.xlsm. Sedang 

untuk memodifikasi terjemahan atau menambah terjemahan bahasa baru, lihat di sheet ‘Text-
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Translations’. StatPlanet tersedia dalam bahasa-bahasa berikut ini. Lihat juga dibawah mentang 

bagaimana menggunakan karakter-karakter  internasional seperti Bahasa Rusia (lihat dibawah).  

 Bahasa Indonesia (atas kontribusi dari Pemerintah Indonesia) 

 Bahasa Denmark (atas kontribusi Peter Erbs-Maibing, Research Centre for Prevention 

and Health, Denmark) 

 Bahasa Belanda 

 Bahasa Inggris 

 Bahasa Perancis 

 Bahasa Jerman 

 Bahasa Yunani 

 Bahasa Portugis-Brasil (atas kontribusi dari Instituto Centro de Vida) 

 Bahasa Rusia (atas kontribusi Andrey Loschilov) 

 Bahasa Spanyol 

StatPlanet juga mendukung karakter internasional. Untuk menggunakannya, ikuti langkah-

langkah berikut: 

1. Hapus file ‘settings.csv’ pada folder utama dan juga folder ‘web’. 

2. Di dalam StatPlanet Data Editor, masuk ke sheet ‘Settings’. Dibawah ‘Startup options – 

Data format’, pilih: TXT (tab-separated values). Lalu klik pada ‘Save settings’. 

3. Karakter internasional sekarang dapat digunakan pada StatPlanet versi offline. Untuk 

web, versi uji coba saat ini masih hanya disediakan untuk peta Shapefile pada StatPlanet 

Plus, pada folder ‘int_character_sets’. Copy file ‘content.swf’ pada folder ini ke dalam 

folder ‘web’, menggantikan file yang ada. 

Karakter yang tersedia adalah: 

 Arab 

 Armenia 

 China (Semua karakter) 

 Cyrilic (untuk Bahasa Rusia, Serbia-Kroasia dan Tajik dan sekitarnya) 

 Devanagari (untuk Bahasa Hindi, Marathi dan Nepali dan sekitarnya) 

 Yunani 

 Ibrani 

 Jepang (semua karakter) 

 Korea (semua karakter) 

 Latin, Latin Extended A, Latin Extended B, Latin Extended Add’l 

 Thai 
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7. MEMPERKECIL UKURAN FILE 

UNTUK  APLIKASI WEB 

StatPlanet diwajibkan agar ukuran file dapat sekecil mungkin. Berikut ini adalah daftar hal-hal 

yang dapat dilakukan untuk mengurangi ukuran file peta interaktif lebih lanjut: 

1. File Data ZIP: Hal ini akan dapat mengurangi ukuran file sampai 70%. StatPlanet secara 

otomatis mendeteksi apakah data berada di dalam file ZIP atau tidak. Nama arsip ZIP 

mestinya adalah ‘data.zip’. Jika ada lebih dari satu data file, ini semua juga dapat di-ZIP 

(Hanya untuk StatPlanet Plus/StatTrends Plus) 

2. Angka desimal: Ukuran file akan sering dikurangi sekitar 50% jika bilangan desimal 

dibulatkan menjadi 2 atau 3 angka dibelakang koma. Macros yang digunakan di dalam 

file StatPlanet_data_editor.xlsm adalah untuk membulatkan semua angka pada sheet 

‘Import’ menjadi dua desimal. Nama Macros itu adalah ‘RoundToDecimalPlaces’ dan 

dapat diatur jika perlu.  

3. Format File CSV: Format CSV dipilih karena dapat membuat ukuran file data menjadi 

tetap minimum, karena nilai data hanya dipisahkan menggunakan tanda koma. 

Dibandingkan dengan file XML yang bisa beberapa kali lebih besar untuk memuat data 

yang sama. 

4. Tidak ada duplikasi: Nama indikator dan deskripsi tidak perlu diduplikatkan pada file 

data. Saat menggunakan StatPlanet_data_editor.xlsm, setiap duplikasi nama indikator 

akan otomatis diganti dengan tanda ‘-’. Nama indikator hanya perlu dituliskan pada 

tahun pertama di seri data tersebut. Untuk deksripsi indikator, duplikasi juga ditiadakan 

– lihat di bagian ‘Deskripsi Indikator’ untuk informasi lebih jauh. 

5. Kurangi ukuran peta (hanya versi shapefile): Peta itu sendiri juga seringkali lebih besar 

dari gabungan program StatPlanet dan file datanya. Perangkat lunak SIG dapat 

difungsikan untuk mengurangi tingkat detail dari peta tersebut. Ada juga perangkat 

lunak gratis yaitu MapShaper – www.mapshaper.org. Untuk menyederhanakan petanya, 

unggah (upload) shapefile (misalnya map.shp), tentukan persentase proses 

penyederhanaannya di bagian bawah layar, dan klik ‘export’ di sudut kanan-atas layar. 

Pilih format ekspor pertama poligon ‘shapefile’, dan klik ‘create’. Tidak berapa lama 

kemudian, link unduh (download) akan muncul dibawah. Setelah mengunduh file, 

gunakan file ini untuk mengganti peta shapefile yang ada (map.shp). File map.dbf tidak 

perlu dimodifikasi. 

  

http://www.mapshaper.org/
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LAMPIRAN 1. MEMBUAT PETA FLASH 

Untuk membuat peta interaktif sendiri menggunakan StatPlanet, membutuhkan hal-hal berikut: 

 StatPlanet atau StatPlanet Plus 

 Adobe Flash CS3 atau yang lebih baru 

 File peta dalam format vektor, bisa berupa Adobe Illustrator (.ai), Freehand (.fh*,.ft*) 

atau Adobe Flash (.swf) 

(Perhatikan juga cara mengubah gambar menjadi format vektor yang sesuai) 

Untuk menyiapkan peta yang dapat dipakai pada StatPlanet, yaitu membuka peta template – 

‘map.fla’ – yang berada pada folder ‘StatPlanet_Custom_Map’. File ini berisi empat buah layer 

yang mengandung sebagai berikut: 

 Layer peta: Layer ini berisi bentuk peta (misalnya regional atau provinsi) 

 Layer batas: Layer ini berisi peta batas. 

(Catatan: mulai versi 2.3, teks label peta dibentuk secara otomatis dan tidak ditambahkan 

manual) 

Sebagai contoh hasil akhir mestinya berbentuk seperti berikut ini, lihat pada file 

‘map_example.fla’ (ditampilkan dibawah ini) 

 

http://www.statsilk.com/software/statplanet
http://www.statsilk.com/software/statplanet-plus
http://en.wikipedia.org/wiki/Adobe_Flash
http://en.wikipedia.org/wiki/Vector_graphics
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Langkah 1. Layer peta 

Sebelum memasukan peta ke dalam peta template (map.fla), yang termudah adalah dengan 

mengeditnya terlebih dahulu pada dokumen baru. 

 Buka dokumen baru (File > New) 

 Impor peta. Melalui File > Import to Stage, dan pilih file peta 

 Memilih semua obyek (Edit > Select all) 

 Pisahkan obyek-obyek pada peta dengan menekan CTRL+B (atau melalui menu: Modify 

> Break Apart). Mungkin ini perlu dilakukan beberapa kali sampai obyek-obyek tersebut 

tidak dapat dipisahkan lagi. 

o Apa yang harus dilakukan jika kotak persegi menutupi peta: 

Kadang-kadang sebuah kotak persegi tiba-tiba muncul padahal sebelumnya tidak 

ada. Jika hal ini terjadi, klik dimanapun diluar area yang sedang terpilih untuk  

mendiadakan pilihan. Lalu klik pada kotak persegi tersebut dan tekan ‘delete’. 

Sekarang peta dapat terlihat lagi. (Catatan: jika ‘Break Apart’ dilakukan terlalu 

banyak, kotak dan peta akan mejadi satu, dan peta akan menghilang. Maka kita 

perlu kembali dan melakukan lagi, dan menghapus kotak itu saat masih terpisah 

dengan obyek peta. 

 Pilih semua (Edit > Select all) 

 Copy peta (Edit > Copy) 

 Buka template peta (map.fla) 

 Pilih ‘Frame’ pertama pada ‘timeline’ di layer ‘map’ (biasanya dibagian teratas layar 

monitor, lihat juga pada contoh gambar diatas – ‘Frame’ pertama sepertinya berupa 

kotak putih dengan sebuah lingkaran di dalamnya). 

 Paste petanya (Edit > Paste in Place) 

 Dobel klik pada batas peta. Mestinya semua batas langsung terpilih dengan sekali jalan. 

Sebaliknya, tekan terus tombol ‘Shift’ dan dobel klik pada batas sisanya yang lain. 

Setelah semua batas terpilih, ubahlah ketebalan garis batas melalui Panel ‘Properties’. 

Klik pada menu drop-down yang sedang memilih ‘Solid’, dan ubah menjadi ‘hairline’. Jika 

semua border memiliki warna yang berbeda, gantilah menjadi satu warna melalui klik 

pada kotak pilihan warna. Pilihlah warna yang diinginkan (misalnya warna hitam) 

 Sekarang pilihlah obyek-obyek peta yang berbeda satu persatu dan ubahlah masing-

masing ke dalam ‘Movie Clip’. Untuk mengubah menjadi ‘Movie Clip’, tekan tombol F8 

(atau menu: Modify > Convert to Symbol). 

o Apa yang harus dilakukan jika obyek peta tidak terpisah dengan benar: 

Kadang-kadang objek peta tidak terpisah dengan benar, karena batasnya tidak 

menyatu dengan baik. Yang bisa dilakukan adalah menggambar batas yang sudah 
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ada agar objek-objek itu menyatu lagi, atau  menggambar menggunakan ‘Pencil 

Tool’. Untuk menyatukannya, klik pada bagian ujung satu garis tepat dititip dimana 

garis itu tidak menyatu dan tariklah garis ke titik yang mestinya bergabung. 

Alternatif lain, klik ‘Pencil Tool’ pada ‘Drawing Toolbar’ (biasanya di sebalah kiri). 

Lalu gambarlah garis dimana ada jarak pemisah. Kalau sudah selesai, obyek mestinya 

sekarang terpisah. 

o Apa yang harus dilakukan jika peta hanya berisi batas peta, bukan obyek-obyek 

peta: 

Jika peta yang ada hanya berisi peta batas, dapat dilakukan untuk ‘mengisi’ batas 

tersebut dengan ‘Paint Bucket Tool’. Pilih ‘Paint Bucket Tool’ pada ‘Drawing Toolbar’ 

(biasanya disebelah kiri) dan klik di dalam batas peta yang akan diisi. Batas yang 

kosong ini dapat diisi dengan sembarang warna. 

 Buatlah sembarang nama (instance name) untuk tiap ‘Movie Clip’. ‘Instance name’ ini 

dimasukan melalui panel ‘Properties’ yang biasanya dibawah bagian ‘Stage’ (lihat juga 

contoh gambar diatas). ‘Instance name’  ini tidak boleh berisi spasi. Dan juga, lebih baik 

menandai berupa kode daripada nama yang sebenarnya. Nama yang sebenarnya dapat 

ditentuka kemudian melalui StatPlanet_data_editor.xlsm, yang bisa mengikutkan spasi. 

 Ukuran dan posisi peta diatur pada tahap selanjutnya pada StatPlanet_data_editor.xlsm 

(di dalam file Excel sheet ‘Settings’ 

Langkah 2. Layer batas 

 Begitu ‘Movie Clip’ selesai dibuat, batas-batasnya akan tersembunyi dari tampilan. 

Untuk menampilkannya lagi, pilih (select) semua ‘Movie Clip’ yang sudah dibuat satu per 

satu, sambil menekan tombol ‘Shift’. Setelah semua terpilih, klik Edit > Cut. Batas-batas 

peta akan muncul kembali. 

 Sekarang pilih batas peta dengan dobel klik tiap bagiannya. Mestinya ini dapat memilih 

semua batas dalam sekali jalan saja. Jika belum terpilih semua, tekan tombol ‘Shift’ 

sambil dobel klik pada batas-batas yang belum dipilih. Begitu semua sudah dipilih, tekan 

CTRL+G (atau gunakan menu: Modify > Group) 

 Setelah semua batas peta dimasukan dalam satu group, ‘Movie Clip’ dapat disusun lagi. 

Pilih Edit > Paste in Place. Saat ‘Movie Clip’ dalam posisi dipilih (select), klik kanan 

dimanapun, dan dari menu popup, pilih Arrange > Send to Back. Sekarang peta batas 

muncul dibagian paling atas. 

 Klik dimanapun diluar area yang dipilih, untuk meniadakan pilihan. Lalu klik dimana saja 

pada peta batas. Ini harus cukup teliti agar jangan sampai tidak sengaja meng-klik salah 

satu peta ‘Movie Clip’. Setelah terpilih, masuk Edit > Cut. Kemudian pilih ‘Frame’ 

pertama pada layer ‘batas’ di panel ‘Timeline’, dan masuk ke Edit > Paste in Place. 
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 Saat batas dalam keadaan dipilih, ubahlah menjadi ‘Movie Clip’ dengan menekan 

tombol F8 (atau melalui menu Modify > Convert to Symbol) 

 Pada panel Properties Movie Clip dibawah ‘Stage’, masukan ‘Instance name’ untuk 

‘Movie Clip’ batas: batas 

Langkah 3. Publikasi file peta 

 Jika peta sudah siap, publikasikan atau ubahlah peta menjadi file flash (.swf) (File > 

Publish) 

 Masuk ke folder yang berisi file map.fla. Disini ada file baru ‘map.swf’. Copy dan Paste 

file ini ke folder ‘Web’ (untuk StatPlanet versi online), menggantikan file ‘map.swf’ yang 

ada. 

Langkah 4. Membuat link peta pada StatPlanet Data Editor 

 Pada StatPlanet_data_editor.xlsm, pertama masukan ‘nama asli’ peta regional, dan 

kemudian ‘instance name’ atau kode yang digunakan dalam file peta (map.fla) 

 Dibagian sheet ‘Import’, gantilah nama contoh (yaitu nama provinsi di Kenya) dengan 

nama yang kita inginkan. Lalu tekan tombol ‘Save data’. 

 Masuk ke sheet ‘Data’ (nama sheet berada dibagian kiri-bawah program Excel). Pada 

bagian atas seharusnya daftar contoh kode (CEN, COA, EAS, dan seterusnya). Hapuslah 

kode ini dan gantilah dengan kode pada file peta yang digunakan sebegai ‘instance 

name’. Urutan namanya juga harus sama dengan nama peta pada sheet ‘Import’. (Pada 

contoh ini nama daerahnya adalah Central, Coast, Easter... dst, dan kode terkait di sheet 

‘Data’ adalah CEN, COA, EAS.... dst) 

 Kembali ke sheet ‘Import’ dan masukan data untuk peta kita ke sini. Juga bisa dilakukan 

dengan menggunakan tombol ‘Import data’ untuk emngimpor data secara otomatis. Jika 

impor gagal, biasanya karena nama lokasi peta dari file yang diimpor tidak dikenali. Jika 

ini tejadi, maka nama-nama yang keliru ini perlu ditambahkan pada sheet ‘Import 

names’. Lihat juga dibagian ‘Mengimpor data’ 

 Setelah data ditambahkan, tekan tombol ‘Save data’ 

 Masuk kembali ke folder ‘Offline’ dan jalankan StatPlanet.exe untuk melihat hasil jadi 

peta kita. Atau masuk ke folder ‘Web’ dan buka file StatPlanet.html untuk melihatnya 

melalui web-browser. Jika ingin mempublis peta inteaktif ini ke website, copy dan paste  

isi dari folder ‘Web’ ke web-server. Juga lihat pada file StatPlanet_small.html sebagai 

contoh bagaimana peta ini dapat diintegrasikan dengan web-page yang sudah jadi. 

Langkah 5. Memposisikan peta (pilihan) 

Untuk mengubah posisi dan ukuran peta, arahkan mouse ke kanan-bawah layar untuk 

menampilkan kontrol tampilan peta: 
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 Zoom: Tampilan peta dapat diperbesar dan diperkecil menggunakan tombol ‘zoom in’ 

dan ‘zoom out’ atau dengan menggeser zoom slider ke atas dan ke bawah. Jika mouse 

yang digunakan memiliki roda scroll ditengah, juga dapat digunakan untuk 

memperbesar atau memperkecil. 

 Menggeser peta: Klik dan geser peta dengan mouse untuk memindah ke lokasi baru. 

Jika peta telah berada di posisi yang benar, klik kanan dan pilih ‘Copy map coordinates’. Pada 

StatPlanet Data Editor, masuk ke sheet ‘Map regions’, pilih cell dibawah ‘X’, lalu paste koodinat 

tersebut ke sini. 

Langkah 6. Label teks (pilihan) 

 Untuk menyembunyinkan/memunculkan label teks pada peta, klik kanan dan klik pada 

‘Show text labels’ pada StatPlanet_data_editor.xlsm (sheet ‘Import’, dibawah tombol 

‘Save’) 

 Klik pad ‘Save data’ dan bukalah StatPlanet untuk melihat hasilnya. Biasanya posisi 

beberapa atau semua label teks masih perlu diatur lagi. 

 Untuk emngatur posisi label teks ini, klik kanan dimana di dalam StatPlanet dan pilih 

‘Move text labels or map points’ pada menu. Klik pada label teks untuk menggeser ke 

posisi baru. 

 Setelah selesai menggeser label teks, klik kanan dan pilih ‘Copy text label coordinates’ 

pada menu. 

 Pada StatPlanet Data Editor, masuk ke sheet ‘Settings’. Pilih cell disebelah ‘Text label 

coodinates’ dan paste koodinat tersebut ke sini. (mungkin perlu juga memodifikasi 

setting yang lain pada sheet ini, seperti misalnya ukuran font) 

 Klik pada ‘Save settings’ (atau cara lain, ‘Save data’ pada sheet ‘Import’). Koodinat 

sekarang sudah di simpan untuk penggunaan StatPlanet selanjutnya. 

 Melalui sheet ‘Settings’, juga bisa dilakukan perubahan setting tambahan, seperti 

ukuran font untuk label teks. 
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LAMPIRAN 2. PETA TUMPUKAN LAYER 

Di bagian ini menjelaskan bagaimana membuat peta yang terdiri dari tumpukan layer, contoh 

misalnya untuk memperlihatkan perubahan batas pada kurun waktu tertentu, atau jika peta 

terdiri dari beberapa tingkatan administrasi (misal provinsi dan kabupaten) dalam satu aplikasi 

StatPlanet. 

Langkah pertama adalah mengubah pengaturan pada StatPlanet_data_editor.xlsm, sheet 

'Settings'. Dibawah ‘Map options’, atur nilai dari ‘MAP-ND-TR’ menjadi ‘TRUE’ yang akan 

membuat peta yang tidak memiliki data menjadi transparan. Contohnya adalah peta yang 

terdiri dari 2 layer. Layer pertama berisi area 1a, 1b dan 1c, kemudian layer 2 berisi 2a, 2b dan 

2c. Jika suatu indikator hanya memiliki data untuk layer 1, area 1a, 1b dan 1c, maka layer 1 akan 

terlihat dan layer 2 akan tidak nampak (karena area 2a, 2b dan 2c tidak memiliki data). 

Sebaliknya, layer 2 akan terlihat dan layer1 akan tersembunyi jika data hanya terdapat pada 2a, 

2b dan 2c. 

Untuk membuat peta sendiri yang terdiri dari tumpukan layer, semua area peta (objek peta) 

harus memiliki identitas unik. Lalu pada StatPlanet_data_editor.xlsm, setiap area peta harus 

memiliki kolom yang terpisah (misalnya pada contoh diatas, harus ada enam buah kolom: 1a, 

1b, 1c, 2a, 2b, dan 2c). Tiap area peta juga memerlukan objek pembatas tersendiri yang 

memiliki identitas unik juga. Hal ini diperlukan karena tidak hanya area peta, tetapi batasnya 

pun ikut berubah jika terjadi perubahan peta dan perangkat lunak harus mengetahui obyek 

pembatas yang menjadi milik setiap obyek area. 

Sebuah contoh peta dengan dua layer disertakan dalam folder ‘Create_Flash_Maps’. Contoh ini 

ditampilkan di dalam folder “Web_2layers_example” (dengan membuka StatPlanet.html 

melalui web browser). Jika menggeser time slider ke tahun “2010”, ketiga provinsi di bagian 

barat Kenya (pada layer peta 1) akan dijadikan satu dengan provinsi ‘hypothetical’ (pada layer 

peta 2).  Hal ini sudah dilakukan dengan tahapan sebagai berikut: 

1. Sebuah layer peta baru “map2” ditambahkan dalam file Flash ‘map_example_2layers.fla’. 

Layer ini berisi provinsi hipotesis (hypothectical) bagian barat yang baru (gabungan dari 3 

provinsi bagian barat yang ada). Ini diberi instance name (ID): WESBIG 

2. Sebuah layer batas yang baru “borders2” ditambahkan. Layer ini berisi batas untuk wilayah 

peta yang baru. Yang ini juga perlu diberi instance name yang sama, dengan tambahan 

huruf ‘b’ (untuk ‘border’/batas), menjadi WESBIGb 

3. Layer batas baru “borders1” ditambahkan yang menjadi batas pemisah bagi tiga provinsi 

barat yang kemudian menjadi satu provinsi baru yang besar. Semestinya batas ini akan 
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tersembunyi jika layer peta kedua tampil (normalnya hanya ada satu batas bagi 

keseluruhan peta, batas tidak ditentukan secara terpisah untuk tiap wilayah – pada kasus 

ini, tetap ada satu simbol batas untuk keseluruhan peta, tetapi batas bagian baratnya 

dihapuskan). Seperti diatas, batas ini harus memiliki nama yang sama yang berhubungan 

dengan peta wilayah, dengan tambahan huruf ‘b’. Disini batas tersebut diberi nama 

sebagai: RIFb, WESb dan NYAb (berhubungan dengan peta wilayahnya RIF, WES dan NYA). 

4. Wilayah peta baru ditambahkan ke dalam StatPlanet_data_editor.xlsm. Diberi nama 

‘Western Big’ pada sheet ‘Import’ dan ID penghubungnya ‘WESBIG’ pada sheet ‘Data’. 

5. Untuk tahun 2010, data dihapuskan dari provinsi Nyanza, Riftvalley dan Western, jadi 

provinsi-provinsi ini tidak terlihat jika time slider menujuk tahun 2010. Pada tahun yang 

sama, data ditambahkan untuk provinsi Wester Big, jadi provinsi ini akan terlihat di tahun 

2010. 
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LAMPIRAN 3. MENGUBAH GAMBAR 

MENJADI FORMAT VEKTOR 

Mengubah file gambar Bitmap menjadi format vektor secara otomatis 

menggunakan Adobe Flash 

Mengubah file gambar Bitmap menjadi vektor tidak mungkin dilakukan dengan sempurna, 

tetapi dengan beberapa kali percobaan bisa juga diperoleh hasil yang bagus. Untuk mengubah 

gambar Bitmap, pertama-tama impor file tersebut ke Flash (File > Import to Stage). Lalu pilih 

gambar tersebut, pilih Modify > Bitmap > Trace Bitmap. 

Dibutuhkan beberapa percobaan menggunakan pengaturan peruntutan berikut ini untuk 

mendapatkan hasil yang optimal: 

 Color threshold (ambang pewarnaan): Meningkatkan nilai ini akan menurunkan jumlah 

warna pada gambar vektor yang dihasilkan. (Saat membandingkan dua piksel, jika 

perbedaan nilai warna RGB lebih kecil daripada nilai ambang warna yang dicantumkan 

disini, piksel-piksel ini akan dianggap memiliki warna yang sama). 

 Minimum area (area minimal): Meningkatkan nilai ini untuk menurunkan jumlah obyek 

(shape) yang dihasilkan pada gambar vektor. Ini adalah jumlah piksel disekitar sebuah 

piksel yang diperhitungkan jika ada penentuan warna pada sebuah piksel tersebut. 

 Curve fit (kesesuaian kurva): Bagaimana tingkat kelengkungan dari garis yang akan 

digambar. 

 Corner threshold (ambang sudut): Pilihlah berapa banyak sudut yang dipertahankan. 

Nilai-nilai berikut ini menggambarkan pengaturan seperti apa yang digunakan untuk membuat 

vektor yang sangat mirip dengan bitmap yang original. Bagaimanapun juga, pengaturan berikut 

tidak disarankan jika jumlah obyek yang dibuat sangat banyak. Pengaturan seperti ini juga 

dapat menyebabkan program Flash menjadi Crash. 

 Color Threshold: 10 

 Minimum Area: 1 piksel 

 Curve fit: Pixels 

 Corner Threshold: Many Corners 

Merunut garis file bitmap secara manual menggunakan Adobe Flash 

Jika perunutan file gambar secara otomatis tidak mendapatkan hasil yang diinginkan, dapat 

dilakukan penggambaran garis dengan tangan. Kecuali jika peta yang kita peroleh terlalu besar 
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dan kompleks, proses ini tidak memerlukan waktu yang sangat lama.  Caranya adalah sebagai 

berikut: 

1. Ubah peta menjadi Movie Clip (Modify > Convert to Symbol) 

2. Pada bagian panel ‘Properties’ dibawah, klik pada ‘Color Effect’, drop-down pada ‘Style’ 

dan pilih ‘Alpha’. Ubahlah nilai menjadi kira-kira 30% (jadi garis-garis peta tetap masih 

terlihat jelas). 

3. Masukan layer baru (Insert > Timeline > Layer) 

4. Pilih ‘Line tool’ pada ‘Drawing Toolbar’, dan gambar garis pada layer baru mengikuti 

garis-garis pada peta dilayer bawahnya. Pastikan bahwa semua garis-garis itu saling 

bersentuhan. Untuk menggambar sebuah kurva, pertama gambarlah satu garis lurus. 

Lalu gantilah kursor mouse menjadi ‘Selection Tool’, dan klik dimanapun dibagian 

tengah garis, sampai muncul lambang kurva pada kursor dan geser ke arah lain, 

tergantung keinginan. 

5. Pilih ‘Paint Bucket tool’ dan klik di bagian dalam dari garis-garis yang tergambar untuk 

membuat peta area. Jika tidak berhasil, kemungkinan batas-batas yang digambar tidak 

saling bersentuhan. Perbesarlah agar jarak pemisah itu dapat terlihat. 

6. Hapuslah layer paling bawah yang berisi gambar bitmap. 

Mengubah file shape GIS (.SHP) menjadi format vektor untuk Adobe Flash 

Peta untuk SIG (Sistem Informasi Geografis) biasanya menggunakan shapefiel ESRI.  File-file ini 

dapat diubah menjadi file vektor Adobe Illustrator menggunakan perangkat lunak seperti 

ArcGIS atau MA Publisher. Pengubahan menggunakan ArcGIS dapat dilakukan melalui ‘File > 

Export Map’. Pada bagian ‘Save as’, drop-down menu pilih format file ‘AI’. Lalu klik ‘Save’. Fiel 

Adobe Illustrator (AI) dapat diimpor secara langsung melalui Flash. 

Mungkin saja pertama-tama kita ingin membuka gambar pada Adobe Illustrator, mengekspor 

gamabr tersebut menjadi file Flash SWF, dan mengimpor SWF tersebut menjadi Flash. 

Mengimpor SWF kadang-kadang hasilnya lebih bagus dari pada mengimpor dari file AI. 

Jika tidak memiliki program-program diatas, dapat dilakukan menggunakan pengubah file 

Shapefile ke SVG gratisan, yaitu shp2svg. Lihat dibawah ini cara mengubah gambar SVG menjadi 

format yang dikenali oleh Flash.   

Mengubah file gambar vektor (seperti SVG) menjadi format vektor yang dikenali 

Adobe Flash 

Gunakanlah Adobe Illustrator untuk membuka file dan ekspor file tersebut menjadi format yang 

dituju. Hasil yang terbaik adalah jika menggunakan Adobe Illustrator untuk mengekspor gambar 

menjadi Adobe Flash SWF, dari pada mengimpor SWF menjadi Flash. 

http://www.carto.net/svg/utils/shp2svg/
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Jika tidak memiliki Adobe Illustrator, dapat mengubah file menggunakan editor grafik vektor 

gratisan Inkscape. Lalu bisa juga menggunakan SVG2SWF yang gratis untuk sebagai alat untuk 

mengubahnya. 

 

http://inkscape.org/
http://svg2swf.sourceforge.net/

